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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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Mudik berarti produktivitas turun drastis atau
malah nol? Jangan sampai deh! Tapi masa harus
bawa-bawa PC kita ke udik? Gadget dan layanan
operator ponsel bisa jadi solusi.
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Proyek Digital
Banyak pembaca menanyakan, kapan buku kedua yang diterbitkan

PCplus bisa didapat? Ada juga yang menanyakan CD Seri III. Sebagian
menanyakan, kenapa judul buku yang tadinya The Best Articles of PCplus
berganti judul menjadi Langkah Mudah Mengakali Windows?

Semuanya terjawab sudah. Buku kedua PCplus sudah bisa Anda
dapatkan di pasaran. Di dalamnya, terdapat CD PCplus seri III yang
memuat dokumen digital PCplus dari edisi 61 sampai dengan 80. Masih
ada pula software-software utiliti terbaik yang pernah dimuat di PCplus
yang kami sertakan dalam CD itu.

Tentang judul, buku itu sendiri
mengalami tiga kali perubahan.
Pertama kali kami memilih “The
Best Articles of PCplus”. Tapi
rasanya sayang kalau
memisahkan buku
kedua dengan buku
pertama kami yang sukses
di pasar, “Langkah Mudah
Merakit PC”. Oleh karenanya,
kami menggantinya dengan
“Langkah Mudah Mengakali
Windows”. Dalam proses
perjalanannya, bagian
pemasaran kami menyarankan
kata “Mengakali” diganti
dengan kata lain karena
konotasi kata ini terlalu negatif
dan kurang menjual. Dan
akhirnya, terbitlah “LANGKAH
MUDAH OPTIMALISASI WINDOWS”.

Bila Anda tidak ingin kehabisan, segeralah ke Toko Buku Gramedia
terdekat di kota Anda. Sekali lagi, ini bukan promosi karena untuk edisi ini
kami baru mendistribusikannya lewat TB Gramedia. Mudah-mudahan
dalam waktu tidak lebih dari sebulan, buku tersebut sudah dapat Anda
peroleh di toko buku manapun di kota Anda, atau bahkan di agen-agen
koran tertentu.

Sementara, di PCplus kali ini, kami suguhkan juga proyek-proyek
digital, utamanya yang berhubungan dengan layanan untuk pulang mudik
nanti. Perlu Anda tahu, beberapa vendor TI dan telekomunikasi saat ini
sudah menyiapkan berbagai jenis layanan, yang bisa Anda manfaatkan
menemani perjalanan mudik Lebaran bulan depan. Apa saja dan seperti
apa layanannya, Anda bisa menyimaknya di plusFokus edisi ini.

Tentu saja, masih banyak tulisan-tulisan lain yang tak kalah menarik.
Salah satunya adalah kelanjutan dari plusFokus edisi lalu tentang
mencetak foto digital. Di rubrik plusKiat, Anda bisa melihat perban-
dingan dari beberapa pengolahan foto digital yang kami lakukan.

Selamat menikmati sajian kami, pembaca mulia.

Salam hangat dari Palmerah
  Redaksi

BUKU RUBRIK, DAN TIPS
Salam hormat dari

penggemarmu di Gresik. Sebagai
seorang pembaca setia PC+ dan
pemula dalam hal komputer, saya
ingin memberi saran &
mengajukan pertanyaan.
1. Beberapa waktu yang lalu  PC

+ pernah mengatakan akan
menerbitkan buku The Best
Article of PC+ di ultah ke-3-
nya. Kenapa sekarang diganti
dengan buku Langkah Mudah
Mengakali Windows?

2. Saya setuju agar rubrik
plusPonsel dihapus tetapi
berita harganya saja yang
dihapus, sedangkan info
ponsel terbarunya harus tetap
ada agar kita tidak
ketinggalan berita tentang
ponsel yang lagi ngetren
sekarang.

3. Beri tips dong gimana cara
meng-uninstall program
Quick Time Player yang tidak
ada di Control Panel.
Sebelumnya saya mencoba
untuk men-delete-nya lalu
muncul tulisan "Deleting,
Moving, make some applica-
tion can not work". Sehingga
saya membatalkannya. Tolong
jawabannya jangan "Lihat
PC+ edisi yang lalu" karena
saya baru 3 bulan ini
berlangganan PC+ .

Terima kasih atas jawaban
dan dimuatnya e-mail  saya ini.
Semoga PC+ di umurnya yang ke-
3 ini makin PLUS BICARA PC.
Gracias!

Wong Alim
co_tobat37@yahoo.com

Red: 1. Bukan diganti isinya, tapi
cuma judulnya dipilih yang paling
pas. Judul terakhir yang kami pilih,
“LANGKAH MUDAH
OPTIMALISASI WINDOWS,
Kumpulan Trik dan Software
Terbaik PCplus”. Anda bisa
mendapatkannya di toko buku
terkemuka di kota Anda atau
menghubungi Bagian Layanan
Pelanggan PT Prima Infosarana
Media (5483008 ext 3340 atau
langganan@infokomputer.com).
2. Rubrik plusPonsel digantikan
dengan rubrik plusWireless.
Dengan dimuatnya e-mail ini, diskusi
tentang rubrik plusPonsel diakhiri
sampai di sini. Terima kasih atas
masukan dan kritik dari Anda
semua. 3. Tidak ada masalah Anda
buang sekalipun ada peringatan
semacam itu. Anda masih bisa
mengaksesnya dengan program
yang lain.

MEMAKSA SANTAP LINUX
Sebelumnya saya ucapkan

selamat ulang tahun untuk
PCplus. Semoga bertambahnya
umur bukan menjadi alasan bagi
PCplus untuk menjadi "lambat".

Saya benar-benar sangat
terbantu dengan PCplus edisi 149

lalu. Dilihat dari cover-nya, saya
sangat terganggu dengan adanya
bahasan tentang Linux. Karena
saya sangat tidak menyukai
Linux. Namun setelah saya
"paksakan" untuk membaca
artikel tersebut, ternyata artikel
tersebut sangat menarik.
Walaupun sebagian pembahasan
dalam artikel tersebut tidak
semua yang saya mengerti, tapi
bisa membuat saya menjadi lebih
dekat dengan Linux dan berniat
untuk mencobanya.

Namun, seharusnya ada
beberapa pertanyaan yang ingin
saya dapatkan jawabannya ;-)
1. Untuk hal tersebut di atas,

kira-kira varian Linux mana
yang bagus dan di mana saya
bisa download?

2. Berapa kira-kira konsumsi
harddisk untuk sistem Linux?

3. Dari berbagai sumber yang
saya dapat, ada OS Lindows,
bisakah PCplus
membahasnya?

4. Apakah harddisk bad sector
bisa disembuhkan?
Bagaimana caranya? Atau
apakah ada software atau
mungkin freeware yang bisa
menyembuhkannya? Saya
sangat membutuhkan
bantuannya.

5. Apakah dengan bergantinya
kertas PCplus akan
mempengaruhi harga PCplus?
Saya harap tidak!

6. Terakhir, apakah tidak
terbalik jika PCplus yang
memberi hadiah kepada
pembaca? Bukankah
seharusnya pembacalah yang
memberi hadiah kepada
PCplus? Walaupun saya
sendiri tidak punya hadiah
yang akan diberikan untuk
PCplus.

Terima kasih atas perhatian
dan jawabannya.

Dedet
donald_dedet@hotmail.com

Red: 1. Tergantung kebutuhan dan
selera. RedHat, Mandrake, SuSe, dan
sebagainya punya kelebihan dan
kekurangan masing-masing. Di
PCplus, ulasan lebih banyak
mengangkat distro RedHat dan
Mandrake. 2. Tergantung aplikasi
yang akan Anda instal. 3. Kami akan
mengusahakannya. 4. Bisa. Salah
satunya sudah diulas di PCplus edisi
149 tersebut. 5. Memang tidak. 6.
Senang sekali menerima hadiah dari
pembaca mulia.

WORKSHOP DAN CD LINUX
Dear PCplus yang makin

keren aja, to the point aja ya.
Akhir-akhir ini, PCplus kan
sedang mengadakan workshop
Linux di seluruh Indonesia. Saya
sekarang sangat menyesal tidak
bisa mengikuti workshop
tersebut. Terus gimana kalau
tidak mengikuti workshop?

apakah saya bisa mendapatkan
CD Linux dengan cara membeli
atau harus langsung datang ke
Redaksi? Rumah saya sangat
jauh dari Redaksi, bagaimana
saya mendapatkan CD Linux
dan buku panduannya?

Terima kasih atas atensinya
dan tak lupa pula saya ucapkan
selamat ulang tahun yang ke-3
buat PCplus, hip..hip..horay...!!

Indah
deetri_07@telkom.net

Red: CD bisa Anda dapatkan di
Bagian Layanan Pelanggan PCplus
(021-5483008 ext 3704/3340) atau
langganan@infokomputer.com.
Thanks atas ucapan tulusnya.

GANTI KERTAS DAN
RUBRIKASI

Hi, there... Sebelumnya saya
ingin mengucapkan selamat
ulang tahun yang ke-3 bagi
PCplus, semoga di usianya yang
ketiga ini PCplus bertambah
dewasa, berisi, bermutu, pinter,
dan disayang pembaca :). Saya
juga ingin mengucapkan
selamat dan salut atas tampilan
barunya yang menggunakan
kertas HVS. Memang jadi
kelihatan lebih bagus sih.
Apalagi kalau harganya tetap.
Kalau bisa memang harganya
jangan naik ya, tapi kalau
terpaksa yah asal bisa ditolerir
aja. Pokoknya salut lah!

Tapi biar begitu, tetap aja
ada yang mengganjal nih.
Rubrik plusGame sekarang ini
nongol lagi, tapi kok tidak di
setiap edisi? Kesannya kok
plusGame dianaktirikan? Saya
pecinta game, dan saya tidak
ambil pusing kalau rubrik
plusPonsel dihapus. Tapi jika
sebaiknya rubrik plusPonsel
mau tetap dipertahankan,
plusGame-nya juga donk...

Jadi biar adil gitu lho, yang
mau mengikuti perkembangan
ponsel ada rubriknya, yang
pecinta game juga bisa tetap
mengikuti perkembangan
game-game terbaru lewat
rubrik khusus. Tolong saran saya
diperhatikan yach. Udah deh itu
aja dulu. Sebelumnya thank you.

Deny Suryaatmaja
deny_surya@boleh.com

Red: Terima kasih ucapan selamat
ultahnya. Juga komentarnya
tentang rubrikasi di PCplus. Kami
berusaha untuk tidak
menganaktirikan satu dengan yang
lainnya, tetapi mencoba untuk
mencari jalan terbaik buat
penggemar rubrik masing-masing.
Masalahnya, rubrik-rubrik tersebut
memang terlanjur dicintai sehingga
ketika mereka yang tidak suka
mengusulkan untuk dihilangkan,
sebagian dari Anda pasti ramai-
ramai memrotesnya. By the way,
thanks untuk sarannya.



plusAktual IV • 11 - 17 November 2003
PCplus 152

| 3

Microsoft Sayembarakan Pencipta Virus. Bekerjasama dengan
FBI, US Secret Service dan Interpol, Microsoft menawarkan hadiah sebesar US$250.000 bagi siapa saja
yang mampu memberikan keterangan mengenai pencipta worm MSBlast dan virus Sobig. Untuk
program sayembara ini, Microsoft total mengeluarkan dana sebesar US$5 juta.

Belum lama ini Departemen Kehakiman AS, FBI dan Microsoft mengumumkan penangkapan dua
orang tersangka yang menyebarkan modifikasi dari worm MSBlaster, tetapi mereka masih mengalami
kesulitan untuk mencari orang atau kelompok yang bertanggung jawab atas penyebaran virus Sobig.

Brad Smith, General Council Microsoft, mengatakan, “Virus bukan sekadar kejahatan Internet,
virtual, atau cybercrime. Virus adalah kejahatan yang mengganggu kehidupan nyata masyarakat.”
Sayembara ini dibuka untuk semua orang dari negara mana pun. Orang-orang yang memiliki informasi
bersangkutan dengan para pencipta virus tersebut bsa secara langsung atau online menghubungi
Interpol, Internet Fraud Compliant Center, atau FBI. (raa)

Chip IBM akan Lengkapi Xbox. Microsoft akan melengkapi console Xbox-
nya dengan teknologi prosesor IBM. Saat ini, Sony, Toshiba dan IBM sedang bekerja sama untuk sebuah
proyek. Proyek ini diharapkan bisa menciptakan sebuah teknologi pemrosesan untuk generasi console
Playstation berikutnya. Menurut juru bicara IBM, IBM juga menyediakan teknologi chip-nya untuk
perangkat GameCube Nintendo. (raa)

Microsoft Perkenalkan NGSCB. Teknologi Next-Generation Secure
Computing Base (NGSCB), yang akan menjadi bagian dari Longhorn, merupakan kombinasi dari
hardware dan software yang bisa menciptakan lingkungan operasi kedua dalam sebuah komputer.
Teknologi ini dimaksudkan untuk memroteksi sistem dari kode-kode yang mungkin menyerang sistem
komputer dengan menyediakan keamanan dalam koneksi antar aplikasi, periferal hardware, memori,
dan sistem penyimpanan. NGSCB dilengkapi dengan sebuah “nexus”, komponen software baru untuk
Windows, dan sebuah chip yang juga disebut sebagai Security Support Component yang bisa
menjalankan operasi kriptografik. Untuk bisa menggunakan teknologi dengan requirement yang tinggi
ini, para pengguna komputer nantinya harus mengganti beberapa elemen hardware mereka. (raa)

Arsitektur Mobile MXC Akan Hadir dalam
Smartphone dan Kamera. Motorola memperkenalkan arsitektur perangkat
mobile yang katanya akan memimpin terciptanya dunia perangkat hiburan dan telekomunikasi
berukuran mungil dengan harga yang relatif lebih murah. Arsitektur tersebut adalah Mobile Extreme
Convergence, disebut juga MXC, yang akan hadir dalam platform berukuran 0,64 x 0,8 x 0,056 inchi.
Perangkat tersebut juga akan disertai dengan berbagai fitur seperti MP3 player, DVD player, kamera
digital, dan teknologi fingerprint-recognition.

Platform ini ditujukan untuk mendukung teknologi nirkabel termasuk GSM (Global System for
Mobile Communication), GPRS (General Packet Radio Service), EDGE (Enhanced Data Rates for Global
Evolution) dan WCDMA (Wideband Code Division Multiple Access). Untuk ke depannya, Motorola akan
mengembangkan MXC agar bisa terintegrasi dengan teknologi Bluetooth, Wi-Fi dan Global Positioning
System (GPS). (raa)

Samsung Perkenalkan Teknologi DNIe untuk Pasar
Indonesia. DNIe (Digital Natural Image engine) dan sistem video digital Hypervision High-
Definition merupakan teknologi Samsung yang ditujukan untuk meningkatkan kualitas hiburan bagi
konsumennya. Teknologi ini terdiri dari satu set teknologi pengolah gambar untuk mempertinggi
kontras, mempertajam gambar dan detil, serta memberikan warna alami dam hidup untuk peralatan-
peralatan visual seperti televisi plasma dan televisi 3 panel LCD Projection. DNIe juga dikembangkan
Samsung untuk teknologi video digital dan Hypervision DVD-nya. (raa)

Prosesor Terbaru Intel untuk Value PC. Tanggal 5 November lalu
di Santa Clara, California, Intel merilis produk prosesor terbarunya yang ditujukan bagi pengguna PC
desktop kelas value. Produk Intel Celeron kali ini diluncurkan dengan kecepatan
2,8GHz. Selain ditujukan bagi pengguna PC desktop, Celeron 2,8GHz ini
juga tersedia untuk pengguna mobile PC.

Dibuat berbasis teknologi produksi 0,13 micron,
Celeron terbaru ini menggunakan mode
dudukan soket 478 dan menggunakan
front side bus 400MHz. Untuk
L2 Cache-nya, prosesor
ini dilengkapi
dengan 128KB
cache memory,
masih sama
seperti Celeron
1,7GHz yang dirilis
15 Mei 2002 lalu.
Untuk harganya,
Intel Celeron 2,8GHz
ini dilepas ke pasaran
seharga US$177 untuk
pembelian per seribu unit.

Dengan diluncurkannya
prosesor ini, diharapkan
pengguna PC kelas value dapat
memanfaatkan kinerja yang lebih
cepat lagi dari sistem yang
dimilikinya. Sedangkan produk
motherboard yang dapat
memanfaatkan prosesor tersebut di
antaranya adalah yang menggunakan
chipset i865PE dan i865G. (fmn)

FXP Per-
kenalkan
Printer
Laser
Baru. Ada
tiga printer
monochrome dan
sebuah printer
berwarna yang
diluncurkan oleh
Fuji Xerox Printers
(FXP). Untuk
printer mono-
chrome, FXP
meluncurkan
Phaser 3115,
Phaser 3120 dan Phaser 3130. Ketiganya ditujukan bagi
kalangan binis maupun pribadi dan dijual dengan kisaran harga
antara US$299 sampai dengan US$499. Printer-printer ini
dilengkapi dengan paper tray berkapasitas 250 lembar kertas
untuk berbagai jenis media cetak, termasuk label dan transparansi.

Untuk printer laser berwarna, FXP meluncurkan Phaser 6250
yang merupakan pengembangan dari Phaser 6200. Phaser 6250
dilengkapi prosesor 700MHz dan ditujukan bagi kalangan bisnis.
Printer seharga US$3.888 ini dilengkapi dengan teknologi single-
pass, mampu mencetak 24 halaman per menit dengan kualitas
resolusi tinggi 2400 dpi. (raa)

Sennheiser
Luncurkan Lima
Model Headset
Terbarunya. Kelima headset
tersebut adalah PC110, PC120, PC130,
PC140 dan PC150 – semuanya
ditujukan bagi para pengguna PC
untuk dipakai dengan berbagai
macam aplikasi seperti Internet
Telephony, peralatan game, CD,
file-file MP3, video conferencing
dan VoIP (Voice over IP). Model-
model yang
diluncurkan
mengusung
fitur yang
dilengkapi
dengan microphone mute
dan sistem Active-Shock untuk
mengukur volume yang dihasilkan per milidetik dan mengurangi
volume secara otomatis sampai tingkat keamanan tertentu.

Rangkaian headset Sennheiser ini ada yang berupa in-ear, clip
headset, neckband, dan binaural. Setiap perangkat memiliki 2
buah stereo jack 3,5mm untuk standar industri soundcard. Khusus
untuk model desain in-ear dan clip headset, Sennheiser
menambahkan sebuah jack connection 2,5mm untuk DECT
phones. (raa)

Casio Luncurkan Kamera Digital
4 Megapixel. Kamera baru ini diberi nama Exilim EX-
Z4, kamera pertama di jajaran keluarga Exilim yang dilengkapi
dengan fitur sensor gambar 4
megapixel. Kamera digital ini
memiliki 3x optical zoom, 4x
digital zoom dan snapshot
maksimum 2.304 x 1.728 pixel.
Dengan berat 129g, EX-Z4 tampil
ramping dengan ukuran 87x 57x
23,1mm dan layar monitor 2,0
inchi TFT color LCD.

Kamera ini dibundel dengan software Photo Loader 2.1 untuk
Windows atau Photo Loader 1.1 untuk Macintosh, serta
Photohands 1.0 dan USB driver 1.0 untuk Windows. Format file
yang bisa disimpan oleh EX-Z4 adalah JPEG, standar DCF, dan DPOF
compliant untuk snapshot, AVI (Motion JPEG) untuk movie, serta
format WAV untuk audio. (raa)

SiS Luncurkan SiS661FX. Chipset ini telah
sukses memasuki tahap produksi. SiS661FX digunakan oleh
beberapa vendor motherboard diantaranya adalah Acorp, Asustek,
ACS, Gigabyte, MSI, dan Wistron. SiS661FX mendukung DX9 dan
mengintegrasi mesin grafis 256 bit 3D/128 bit 2D dengan teknologi
SiS Ultra-AGPII. Antarmuka digital 12 bit DDR yang mendukung
digital LCD/TV-OUT memungkinkan display gambar seperti pada
layar monitor CRT, TV atau LCD dengan resolusi maksimum
1600x1200 pada tampilan UXGA full screen. (raa)
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E-mail
merupakan
sarana
penyebaran vi-
rus dan worm
ke komputer.
Komentar ini mungkin akan
diikuti anggukan para
pengguna komputer yang
sudah mengenal Sobig.F, worm
‘bandel’ yang sudah
menginfeksi ribuan komputer
melalui e-mail. Seperti yang
sudah diprediksi oleh para
pakar komputer, setelah
Sobig.F pasti akan muncul
generasi virus atau worm baru
yang tak kalah bandel. Kedua
worm baru itu adalah
Mimail.C dan Mimail.E yang
baru muncul awal bulan
November ini.

Dengan menggunakan
metode serangan DoS (Denial
of Service), kedua worm ini
menyerang situs-situs tertentu
untuk mencuri informasi dari
komputer-komputer yang telah
terinfeksi. Sama seperti Sobig.F,
Mimail.C dan E bisa
mengumpulkan alamat e-mail
dari komputer korbannya dan

menyebarkan dirinya sendiri
dengan memanipulasi kolom
[From] pada e-mail. Domain
alamat pengirim e-mail yang
berisi virus ini mungkin saja sama
dengan domain e-mail Anda.
Pada kolom [From], Mimail.C
mengisikan alamat james@
domain_korban.com sebagai
sender. Sedangkan Mimail.E akan
menulis alamat john@
domain_korban.com pada
kolom [From]. Attachment yang
terlampir dalam e-mail itu
berformat .zip, mungkin
tujuannya supaya user percaya
dan mau menjalankan file
tersebut.

Mimail.C juga memiliki nama
lain I-Worm.Mimail.c, W32/

Mimail.C@mm, Bics, dan I-
Worm.WatchNet. Attachment
yang mengandung Mimail.C
berisi file photos.zip, isinya
adalah file photos.jpg.exe.
Kolom [Subject] berisi Re[2]:
our private photos diikuti
dengan huruf acak di belakang-
nya. Isi dari badan e-mail tersebut
adalah sebagai berikut:

Hello Dear!,
Finally i've found possibility
to right u, my lovely girl :)
All our photos which i've
made at the beach (even
when u're without ur bh :))
photos are great! This
evening i'll come and we'll
make the best SEX:)

Mimail.C dan Mimail.E:
Worm dengan Aksi Serangan

Denial of Service
Right now enjoy the photos.
Kiss, James.
(diikuti dengan huruf acak)

Tak lama setelah Mimail.C,
muncul Mimail.E. Nama lainnya
adalah WORM_MIMAIL.F [Trend],
Win32.Mimail.G [Computer
Associates], Mimail.G [F-Secure],
W32/Mimail-F [Sophos].
Attachment e-mail yang
mengandung worm ini adalah
file readnow.zip, isinya
file bernama readnow.doc.scr.
Kolom [Subject]-nya berjudul
don’t be late! diikuti
dengan huruf acak di
belakangnya. Isi dari badan
e-mail tersebut adalah sebagai
berikut:

Will meet tonight as we
agreed, because on Wednes-
day I don't think I'll make it,
so don't be late. And yes, by
the way here is the file you
asked for. It's all written
there.

See you.
(diikuti huruf acak)

Mimail.C dan E dapat
menginfeksi komputer yang
berbasis sistem operasi Win-
dows 2000, Windows 95,
Windows 98, Windows Me,
Windows NT, Windows Server
2003, dan Windows XP. Sistem
operasi yang tidak dapat
ditembus oleh Mimail.C adalah
Linux, Macintosh, OS/2, UNIX,
dan Windows 3.x. Sedangkan
Mimail.E tidak dapat menembus
sistem operasi DOS, Linux,
Macintosh, OS/2, UNIX, dan
Windows 3.x.

Untuk melindungi
komputer dari serangan kedua
worm ini, para pengguna
komputer harus melakukan
update pada masing-masing
definisi antivirusnya. (raa)

Intel Hadirkan Pentium 4 Extreme Edition bagi
Para Gamer. Prosesor ini mendukung teknologi Hyper Threading (HT) berkecepatan
3,2GHz. Komputer-komputer berbasis prosesor tersebut dirancang untuk memenuhi kebutuhan para
pemain game tingkat tinggi. Intel telah menambahkan 2 megabyte level 3 cache dalam cetakan chip
prosesornya untuk menghadirkan pengalaman bermain game yang lebih nyata.

Prosesor Intel Pentium 4 Extreme Edition dibuat dengan teknologi proses Intel 0,13 mikron dan
menampilkan level 2 cache 512 kilobyte, level 3 cache 2 megabyte, dan sistem bus 800MHz. Prosesor
ini kompatibel dengan keluarga chipset Intel 865 dan Intel 875. Level 3 cache 2 megabyte dapat
memuat buffer frame grafik atau suatu frame video sebelum digunakan oleh prosesor, sehingga dapat
menghasilkan gerakan gambar yang yang lebih cepat dan terlihat nyata saat mengakses memori dan
perangkat I/O. Selain itu, kinerja CPU dan kecepatan pemrosesan data yang dihasilkan juga lebih
tinggi. (raa)

Gigabyte Merilis Tiga Kartu Grafis Baru. Ketiga produk
tersebut adalah GV-N57U128D, GV-N57128D, dan GV-N595U256V. GV-N57U128D, mengusung
platform Nvidia GeForce FX5700 Ultra, dibuat
dengan teknologi proses 0,13 mikron untuk
menghasilkan kecepatan clock yang tinggi.
Kartu ini memperkuat sistem grafis komputer
sehingga para penggunanya bisa menjalankan
aplikasi dan game dengan resolusi dan
kecepatan yang belum pernah mereka rasakan
sebelumnya. Intellisample high resolution
Compression Technology (HCT) bisa
menghasilkan gambar yang tajam dengan
tekstur yang jelas. GV-N57U128D juga dilengkapi
dengan mesin CineFX 2.0 128 bit, serta
mendukung DirectX 9.0, OpenGL 1.5, dan AGP8X
dengan kecepatan 2,1GBps.

GV-N57128D dibuat dengan basis GeForce FX5700 GPU
serta fitur memori 128MB DDRII, AGP8X, dan DVI. Mesin
CineFX 2.0 dan teknologi HCT dikombinasikan untuk
menghasilkan kualitas grafis dan frame rate yang tinggi. Kartu ini juga mendukung DirectX 9.0 dan
OpenGL 1.5 agar kompatibel dengan game-game PC modern.

GV-N595U256V mengusung platform GeForce FX5950 Ultra. Kartu grafis ini memiliki memori
sebesar 256MB dan antarmuka memori 256 bit menawarkan bandwidth memori tinggi yang mampu
menampilkan tekstur gambar beresolusi tinggi. Sama seperti dua saudaranya, GV-N595U256V juga
dilengkapi dengan teknologi HCT dan mesin CineFX 2.0 berkecepatan 2,1GBps, serta mendukung
DirectX 9.0, OpenGL 1.5, dan AGP8X untuk menghasilkan kualitas grafis 3D. Ketiga kartu grafis
Gigabyte ini juga dilengkapi dengan TV encoder yang memungkinkan pengguna komputer
menghubungkan kartu-kartu tersebut ke televisi. (raa)

Penjualan IBM ThinkPad Lampaui 20 Juta Unit. Hal ini
menandai kejayaan ThinkPad sebagai pemimpin dalam teknologi mobile computing, yang sejak
pertama kali diperkenalkan di tahun 1992, telah banyak menampilkan banyak inovasi Thinkpad,
termasuk notebook pertama dengan panel LCD berwarna, LCD berukuran 14 inci, keyboard dengan
ukuran penuh, dan hard drive yang dapat dilepas. IBM ThinkPad menggunakan sistem operasi berbasis
Intel Centrino, dilengkapi dengan 512 MB RAM, prosesor berkecepatan 1.6 GHz, hard drive
berkapasitas 80 GB dan baterai yang bisa bekerja hingga delapan jam. ThinkPad T40 adalah note-
book 14 inci yang paling tipis dan paling ringan di industri yang menggunakan Active Protection
System, yang bisa memroteksi hard drive sebuah sistem komputer mirip dengan airbag yang
melindungi penumpang mobil. (raa)

UMAX Perkenalkan 5 Model
Kamera Digital Terbaru. Umaxindo Persada
sebagai distributor tunggal UMAX di Indonesia kembali
memperkenalkan 5 model kamera digital terbaru, yang
diperuntukkan bagi kalangan entry level. Acara peluncuran yang
diadakan di Hotel Mercure, Jakarta 3 November lalu juga diisi
dengan presentasi produk-produk terbaru tersebut dari  Bennett
Wu, Section Manager Asia Pasific Dept-Sales Division.

Kelima produk dari seri AstraPix yang diluncurkan masing-
masing AstraPix 670, AstraPix 660, AstraPix 590, AstraPix 580, dan
AstraPix 440. Seperti produk untuk entry level hingga semi
profesional, kelima produk yang berbentuk tipis ini memiliki
resolusi mulai 2 megapixel hingga 3 megapixel. Dari kelima produk
tersebut, empat di antaranya memiliki kemampuan interpolasi yang
memungkinkan peningkatan resolusi kamera. Untuk tipe AstraPix
660 yang menggunakan sensor CCD misalnya, dengan teknik
interpolasi, 3,3 megapixel mampu ditingkatkan menjadi sekitar 6
megapixel.

Beberapa fitur lain yang cukup menarik juga dihadirkan
dengan setting yang tergolong mudah. Beberapa tipe misalnya
dilengkapi dengan microphone, memori internal, dan fitur zoom,
baik optik maupun digital. Seperti juga kamera digital lainnya,
kelima monitor tersebut sudah dilengkapi dengan LCD untuk
menampilkan menu maupun melihat hasil foto yang dibuat. (sil)

Info Tol Hadir dalam Menu
Browser Satelindo. Indonesia Media Technologies
(IMT), bekerja sama dengan Jasa Marga dan Satelindo,
menghadirkan layanan SMS informasi jalan tol dalam menu
browser Satelindo. Info mengenai tol ini bisa diperoleh dengan
mengirimkan SMS ke nomor 3422 dengan mengetikkan kode
tertentu. Layanan ini sudah dikemas dalam SIM Card Mentari/Matrix
dan dikhususkan bagi pelanggan Satelindo.

Wilayah jalan tol yang masuk dalam layanan adalah jalan tol
Jagorawi, Tangerang, Cikampek, Cawang, Merak, dan tol Pondok
Pinang. Informasi mengenai ruas jalan tol memang semakin
dibutuhkan, terutama pada saat menjelang Idul Fitri. (raa)

Para Pengusaha Ritel Asia Pasifik
Fokuskan Anggaran TI untuk
Dukung Transformasi Bisnisnya. Itu
merupakan hasil yang diperoleh dari Retail CIO Survey 2003 yang
berlangsung atas kerjasama antara IBM Business Consulting Service
dengan Majalah Executive Technology. Para CIO mengindikasi akan
terjadi peningkatan jumlah outsourcing TI dalam waktu tiga sampai
lima tahun ke depan.  Dari riset yang dilakukan IBM, diperoleh hasil
yang menunjukkan bahwa pebisnis ritel global memiliki fokus
untuk meningkatkan profitnya melalui investasi TI yang kini juga
menjadi strategi bisnis mereka. Mereka ingin meningkatkan akses
data, meng-upgrade sistem POS (Point of Sales) dengan aplikasi-
aplikasi baru yang bisa berhadapan langsung dengan pelanggan,
serta mengelola inventori dan barang dagangannya. (raa)

ISTIMEWA
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Cakrawala Gintings
cakra@e-pcplus.com Bagaimana Pembagian

Kelas dalam Kartu Grafis?

P

Dewasa ini ada
puluhan ragam kartu

grafis beredar di
pasaran. Kartu grafis-

kartu grafis ini
memiliki harga dan

kinerja yang berbeda-
beda. Secara umum

kartu grafis yang
memiliki kinerja ting-
gi akan memiliki har-
ga yang tinggi pula.

rodusen
pembuat
kartu grafis
maupun pembuat chip

utama untuk kartu grafis
memang mengelompokkan
kartu grafis ataupun core yang
diproduksinya menjadi beberapa
kelas. Adapun pengelompokkan
yang sering dilakukan sekarang
adalah pengelompokkan ke
dalam tiga kelas. Kelas-kelas
tersebut adalah kelas value,
kelas menengah (middle), dan
kelas atas (high end) ataupun
kelas performa (performance).
Bila dilihat dari harga jualnya,
kelas value sesuai namanya jelas
menawarkan harga yang
terendah dan kelas atas
tentunya akan menawarkan
harga yang paling tinggi.

ATI DAN NVIDIA
Harus diakui memang

bahwa kartu grafis yang
menggunakan core dari kedua
vendor inilah yang banyak
beredar di pasaran. Dari pihak
ATI dan nVidia sendiri,
pembagian terhadap kelas dari
chip yang dipasarkan sudah
dilakukan.

Pembagian kelas dari chip-
chip ini umumnya didasarkan
pada fitur yang didukung dan
juga pada clock yang digunakan.
Pembagian berdasarkan fitur lebih
berhubungan pada kelas value,
menengah, dan atas tadi,
sementara pembagian
berdasarkan clock lebih pada

variasi dari kelas yang
bersangkutan.

Fitur-fitur yang didukung
oleh suatu chip memang sangat
mempengaruhi kinerja yang
ditawarkannya. Fitur-fitur seperti
vertex shader dan pixel pipeline
sering kali jumlahnya dikurangi
pada chip yang termasuk kelas
lebih rendah. Misalnya pada kelas
atas jumlahnya ada 8, maka pada
kelas menengah jumlah ini
berkurang hingga menjadi 4 saja.
Pengurangan fitur seperti ini akan
mengurangi jumlah transistor
yang diperlukan sehingga akan
menurunkan harga chip tersebut.

Hal seperti ini misalnya terjadi
pada FX5800 dengan FX5600.

Untuk suatu kelas, chip-chip
yang ditawarkan juga memiliki
kemampuan akan clock kerja yang
berbeda-beda. Karena memiliki
fitur yang umumnya sama
(berhubung satu kelas),
perbedaan clock kerja yang
digunakan akan menghasilkan
kinerja yang berbeda pula.

Pembagian berdasarkan clock
kerja yang didukung ini kadang
kala bisa mencapai tiga level,
mirip seperti pembagian kelas
value, menengah, dan atas tadi.
Istilah yang digunakan juga
berbeda antara masing-masing
produsen. Sebagai contoh, ada
yang menggunakan istilah pro
dan ada yang menggunakan
istilah ultra. Tentunya yang
menggunakan clock yang lebih
rendah akan memiliki harga yang
relatif lebih murah.

PRODUSEN KARTU GRAFIS
Setelah dibagi-bagi atas fitur

dan clock kerja yang didukung
oleh produsen pembuat chip,
produsen pembuat kartu grafis
cukup sering melakukan variasi
tambahan lainnya. Variasi yang

dilakukan oleh produsen
pembuat kartu grafis ini
belakangan lebih pada clock
kerja yang digunakan baik pada
core maupun pada memori.
Variasi ini tentunya akan
membagi-bagi lagi kartu grafis
yang ditawarkan.

Pada masa lalu terdapat
variasi yang dilakukan pada jenis
memori yang digunakan,
misalnya SDR-SDRAM 128 bit dan
DDR-SDRAM 64 bit. Variasi yang
dilakukan sekarang pada clock
mencakup penggunaan clock
yang lebih rendah maupun yang
lebih tinggi.

Penggunaan clock yang
lebih rendah akan menurunkan
biaya yang diperlukan sehingga
akan menurunkan harga.
Penggunaan clock yang lebih
rendah ini bisa dilakukan hanya
pada memori saja dan tidak pada
core. Hal ini akan membuat pro-
dusen bisa menggunakan memo-
ri dengan kecepatan yang lebih
rendah yang berharga lebih
murah. Sementara itu menaikkan
clock yang digunakan lebih pada
memaksimalkan kinerja yang
bisa diperoleh menggunakan
kartu grafis tersebut. PC+

Kartu grafis masa kini semakin bervariasi. Kadang kala,
karena terlampau banyak variasinya kita sering kesulitan
untuk mendapatkan kartu grafis yang kita mau dan sesuai
dengan kebutuhan kita.
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Men-download
Hotmail dengan
Hotmail Popper

Y.J. Thurana
thurana@e-pcplus.com

L

Ada alasan kuat
mengapa Microsoft

membeli Hotmail.
Pelopor penyedia jasa

e-mail gratisan
dengan jumlah

penggunanya yang
sedemikian besar

membuat Microsoft
tidak bisa menahan
godaan untuk tidak

meraupnya. Pada
masa itu, siapa yang

tidak memiliki ac-
count di Hotmail

sepertinya bukanlah
pengguna Internet

yang cool. Kalau
boleh jujur, alamat e-

mail pertama yang
saya miliki adalah dari

Hotmail.

alu seperti
biasa
dijalankanlah strategi
dominasi standar.

Account Hotmail dibuat
sedemikian rupa sehingga
hanya bisa dibuka secara online,
atau menggunakan Outlook.
Dengan begini para pengguna
Hotmail hanya punya pilihan
untuk membuka account-nya
secara online atau berpindah ke
Microsoft Outlook sebagai e-
mail client-nya. Jika tidak suka,
tinggalkan saja account
tersebut. Bagi saya (dan
sebagian pengguna Hotmail
lain), pilihan terakhir sepertinya
masuk akal.

Tetapi bagi para kru di
Boolean.ca sepertinya ada
pilihan lain. Buat saja program
yang memungkinkan pengguna
Hotmail untuk bisa mengecek
account mereka dari rumah
dengan POP3 (Post Office
Protocol –-sistem pengambilan
e-mail), tambahkan
kemampuan untuk bisa
mengirimkan e-mail dari rumah
dengan account Hotmail
tersebut seperti layaknya
account SMTP (Simple Mail
Transfer Protocol –-sistem
pengiriman e-mail)  biasa.

Buatlah program tersebut
bisa bekerja dengan sembarang
program e-mail client, cukup
kecil sehingga tidak
mengganggu kinerja komputer,
sediakan secara gratis, maka
terciptalah Hotmail Popper.

MENGGUNAKAN
HOTMAIL POPPER

Pertama-tama, proses men-
download. Alamat yang bisa
digunakan adalah sebagai
berikut: http://
www.boolean.ca/hotpop/
hotpop-2.1.0.exe.

Proses instalasinya dimulai
dengan mengklik dua kali pada
installer file seukuran 1,49MB
ini. Jika ada versi sebelumnya
dari software, installer akan
meminta Anda untuk
menonaktifkannya dulu. Urusan
akan selesai tidak sampai satu
menit sejak klik pertama.

Tidak akan ada tampilan
apapun. Program ini akan

duduk tenang di
System Tray. Klik
kanan pada ikonnya
akan menampilkan
menu pilihan
(Gambar 1). Memilih
Options akan
membuka jendela
Options (Gambar 2).
Jangan mengubah
pengaturan apapun
kecuali jika Anda
mengerti apa yang
Anda lakukan!

Meskipun demikian, ada
beberapa hal yang bisa diutak-
atik dari jendela Options
tersebut. Misalnya:
• Beri tanda cek pada pilihan

Retrieve messages from
folder other than Inbox

(termasuk Include Bulk Mail
Folder jika Anda
menginginkannya) pada saat
pertama Anda menggunakan
program ini. Pilihan ini akan
mengambil SEMUA e-mail
yang ada pada account
Hotmail Anda.

• Isi kolom Proxy jika memang
Anda menggunakan alamat
proxy untuk koneksi Internet.
“Tidak tahu apa yang harus

diisi” berarti “tidak usah
mencoba mengubah-ubah”.

• Beri juga tanda cek pada
pilihan Opera compatibility
mode jika Anda
menggunakan Opera sebagai
e-mail client Anda. Sisa dua
pilihan lainnya terserah Anda.

Pekerjaan sesungguhnya
adalah pengaturan yang
diperlukan pada e-mail client
Anda. Apapun itu, yang penting
dia mendukung POP3 dan SMTP.
Karena begitu banyak dan
beragam e-mail client yang
dipergunakan oleh semua
pembaca PCplus, maka yang akan
dijelaskan di sini hanyalah secara
garis besarnya saja.

Pertama-tama buatlah
sebuah account POP baru. Pada
alamat server tuliskan
"127.0.0.1" (kecuali jika Anda
mengubah alamat tersebut pada
jendela Options tadi, isikanlah
dengan alamat yang sudah Anda
ubah tersebut). Gunakan alamat
yang sama untuk server SMTP.

Kemudian isikanlah user
name dan password yang Anda
gunakan pada account Hotmail
pada pilihan login atau user
name pada e-mail client Anda.
Misalnya:
my_address@hotmail.com or
mr_roboto@msn.com.

Mohon diperhatikan bahwa
password yang digunakan adalah
case sensitive. Maksudnya:
BatMan itu berbeda dengan
batman. Huruf besar dan kecil
berbeda, jadi pastikan tombol
Caps Lock pada keyboard Anda
tidak sedang aktif.

Hal lain yang perlu dicermati
adalah bahwa pada beberapa e-
mail client, Anda perlu
mengaktifkan pilihan enable
SMTP authentication dan
mengonfirmasi untuk
menggunakan user name dan
password yang sama dengan
POP3.

Pengaturan tersebut bisa
juga diakses dari menu yang
biasanya bernama Account
Properties. Gambar contoh

diambil dari e-mail client
The Bat! (Gambar 3).
Lakukan hal yang sama
lagi jika Anda memiliki
lebih dari satu account
Hotmail.

Sekarang, setiap kali
Anda mengecek e-mail
seperti biasa, e-mail dari
account Hotmail Anda
akan ikut diambil.

Sedikit catatan: Pada
Windows NT2000/XP,
Anda haruslah sang
Administrator untuk bisa

mengubah-ubah port untuk POP/
SMTP.

KONFIGURASI
Jika Anda memiliki lebih dari

satu komputer yang saling
berhubungan dan berbagi
koneksi Internet, atau jika Anda
ingin lebih bermain-main dengan
Hotmail Popper, silakan dibaca
lebih jauh.

Jendela Options yang telah
disinggung sedikit di bagian awal
sebetulnya berfungsi untuk

mengonfigurasikan Hotmail
Popper lebih lanjut.

Berikut adalah beberapa
diantaranya:

• Address:
Adalah alamat yang

mengikat Hotmail Popper, dan
secara default di-set ke
127.0.0.1. Jangan diubah jika
Anda menggunakannya hanya
untuk satu komputer. Untuk
internal network, ubahlah
dengan alamat IP komputer Anda
seperti misalnya 192.168.1.42.
Tanyakan teman Anda yang lebih
ahli jika nomer-nomer di atas
membuat Anda bingung seperti
saya.

• POP Port:
Adalah port (semacam jalur)

yang digunakan oleh Hotmail

Popper untuk pengambilan e-
mail. Satu-satunya alasa untuk
mengubah nomor default 110
adalah  jika ada POP server lain
yang sudah terinstal di
komputer Anda.

• SMTP Port:
Sama seperti di atas, dan

sudah di-set ke saluran nomor
25.

• Timeout:
Adalah lama waktu yang

akan disediakan oleh program
ini sebelum ia menyerah
mengambil e-mail. Menaikkan
nilai kadang-kadang bisa
membantu.

• Delay:
Adalah lama waktu (dalam

seperseribu detik) yang akan
disediakan oleh program ini
dalam bertukar perintah
dengan program e-mail client
lokal. Biasanya menaikkan nilai
delay diperlukan jika ada
Firewall yang terinstal dan

Anda mengalami masalah
dalam dunia per-e-mail-an.

Pilihan-pilihan lain sudah
dibahas sebelumnya.

Ada tambahan perintah
yang bisa digunakan pada
Command Line yang bisa
diakses dari menu [klik
kanan]>[Properties] pada ikon
program ini. Perintah /hideicon
akan menghilangkan ikon yang
ada pada System Tray.

Selain itu, secara otomatis
program ini akan “mencipta-
kan” folder sesuai dengan
folder yang ada pada account
Hotmail Anda dan menyortir
pesan-pesan yang masuk ke
tempat yang seharusnya. Misal-
nya pesan dari Inbox akan ma-
suk ke folder Inbox. Pesan Bulk
akan masuk folder Bulk. PC+

Gambar 1

Gambar 2

Gambar 3
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Menyisipkan Search Engine
di Situs Web Anda

Andreas Deni Sekundianto
andrew_groove@hackermail.com

B

Anda mempunyai
homepage di

Internet? Salah satu
fitur penting untuk

situs Web Anda
adalah search engine.

Menyisipkan search
engine pada situs

Web Anda
memerlukan sedikit

pengetahuan
mengenai bahasa

HTML dan javascript.

erikut ini
penulis
berikan
kode JavaScript

untuk menyisipkan search
engine di situs Web. Search
engine yang disisipkan tidak
search engine murni buatan
sendiri, melainkan “meminjam”
search engine dari situs search
engine seperti Google, Yahoo,
Lycos, dan sebagainya.

Anda hanya memerlukan
Notepad atau software pem-
bangun situs Web seperti Micro-
soft FrontPage. Javascript untuk
menyisipkan search engine
tinggal ditambahkan di bawah
<BODY> pada kode HTML
Anda. Berikut ini Javascript-nya:

<SCRIPT
language=JavaScript>
<!--
//Script Author: Andreas Deni
Sekundianto(andrew_groove@
hackermail.com).
//Date: 08-27-2001
//Use all you want provided
you leave in the comments.

function
netsearch(formname)

{
var a1
var a2
var b1
var b2
var c1
var c2
var d1
var d2
var e1
var e2
var f1
var f2
var g1
var g2
var TEXT
var noENGINE
var haveTEXT

TEXT=formname.TEXT.value;
noEngine=true;
haveTEXT=true;

if (TEXT==" ")
{
alert("Tulis dulu dong apa
yang mau dicari!")
haveTEXT=false
}

//ALTAVISTA
a1=formname.altavista.
checked;

a2="http://
www.altavista.digital.com/
cgi-bin/query?pg=q&what=

web&fmt=.&q=
"+TEXT;
if (a1)
{
noEngine=false
if (haveTEXT)
{
newWindow=
window.open(a2,
"av","toolbar,
location,directories,
status,menubar,
scrollbars,
resizable=1")
}
}

//EXCITE
b1=formname.excite.checked;
b2="http://www.excite.com/
search.gw?trace=
a&search="+TEXT;
if (b1)
{
noEngine=false
if (haveTEXT)
{
newWindow=window.open(b2,
"e","toolbar,location,directories,
status,menubar,scrollbars,
resizable=1")
}
}

//HOTBOT
c1=formname.hotbot.checked;

c2="http://
www.search.hotbot.com/
hResult.html?SM=MC&MT=
"+TEXT+"&DV=7&RG=.com&DC=
10&DE=2&OPs=MDRTP&_v=
2&DU=days&SW=web&search.x=
23&search.y=8";
if (c1)
{
noEngine=false
if (haveTEXT)
{
newWindow=window.open
(c2,"h","toolbar,location,
directories,status,menubar,
scrollbars,resizable=1")
}
}

//INFOSEEK
d1=formname.infoseek.checked;

d2="http://
www.infoseek.com/
Titles?qt="+TEXT+"&col=
WW&sv=IS&lk=noframes&nh=
10";
if (d1)
{
noEngine=false
if (haveTEXT)
{
newWindow=window.
open(d2, "i",
"toolbar,location,directories,
status,menubar,scrollbars,
resizable=1")
}
}

//LYCOS

e1=formname.lycos.checked;

e2="http://www.lycos.com/cgi-
bin/pursuit?query="+TEXT+"&
matchmode=and&cat=
lycos&x=33&y=10";
if (e1)
{
noEngine=false
if (haveTEXT)
{
newWindow=window.open(e2,
"l","toolbar,location,
directories,status,menubar,
scrollbars,resizable=1")
}
}

//WEBCRAWLER
f1=formname.webcrawler.
checked;
f2="http://
www.webcrawler.com/cgi-bin/
WebQuery?searchText="+TEXT;
if (f1)
{
noEngine=false
if (haveTEXT)
{
newWindow=window.open(f2,
"w","toolbar,location,directories,
status,menubar,scrollbars,
resizable=1")
}
}

//YAHOO
g1=formname.yahoo.checked;
g2="http://search.yahoo.com/
bin/search?p="+TEXT;
if (g1)
{
noEngine=false
if (haveTEXT)
{
newWindow=window.open(g2,
"y","toolbar,location,directories,
status,menubar,scrollbars,
resizable=1")
}
}

//noENGINE
if (noEngine)
{
alert("Pilih dulu mesin
pencarinya!")
}

// END SCRIPT

}

//Done Hiding-->
</SCRIPT>

Selanjutnya Anda tinggal
membuat form agar search
engine itu dapat digunakan oleh
pengunjung situs Web Anda.
Berikut ini contoh untuk mem-
buat form untuk search engine
tersebut. Anda dapat mengem-
bangkan sendiri form tersebut
sesuai dengan keinginan Anda.

<form name-”engines”>
<p align=”justify”><input
type="checkbox"
name="altavista"
value="ON"><font

color="#FF0000"><b>AltaVista
</b></font><br>
<input type="checkbox"
name="excite"
value="ON"><b><font
color="#000000">Excite

</font></b><br>
<input type="checkbox"
name="hotbot"
value="ON"><font
color="#FF00FF"><b>HotBot
</b></font><br>
<input type="checkbox"
name="infoseek"
value="ON"><font
color="#000080"><b>Infoseek
</b></font><br>
<input type="checkbox"
name="lycos"
value="ON"><font

color="#996633"><b>Lycos
</b></font><br>
<input type="checkbox"
name="webcrawler"
value="ON"><font
color="#008080"><b>
Webcrawler</b></font><br>
<input type="checkbox"
name="yahoo"
value="ON"><font
color="#0000FF"><b>Yahoo!
</b></font>
<input maxLength="200"
size="15" value=" "
name="TEXT">&nbsp;

<input onclick="netsearch
(engines)" type="button"
value="Cari" style="font-
size: 12pt; font-weight:
bold">
<input type="reset"

value="Batal" style="font-
size: 12pt; font-weight:
bold"></p>
</form>

Dengan menyisipkan bebe-
rapa search engine tersebut pa-
da situs Web Anda, pengunjung
dapat mengakses search engine
kesukaan mereka dari situs Web
Anda tersebut. Sehingga
pengunjung lebih mudah dan
cepat dalam melakukan pen-
carian. Selamat mencoba. PC+

Gambar search engine yang sudah jadi. Latar
belakang bisa diganti dengan mengganti link
ke file gambar latar belakang.

Pada saat coding, script untuk menyisipkan search engine diletakkan
setelah <BODY>.

Setelah coding selesai, lihat pada bagian preview tampilan. Jika
sudah benar, maka akan muncul beberapa radio button dengan nama
search engine di sampingnya.
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FIFTH MEDIA XPLORE G18
Banyak Fitur dalam Satu

Genggaman

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

X

waktu
standby selama

100 jam. Luas layar touchscreen
LCD seluas 2,2 inch-nya
mendukung 256 ribu warna dan
resolusi 176 x 240 pixel.

FITUR DAN TEKNOLOGI
PDA Phone berbasis Palm

Operating System 4.1.2 ini
berjalan pada jaringan selular
GSM 900MHz/1800MHz dan
mendukung teknologi GPRS
(General Packet Radio Service).
Xplore G18 menggunakan
prosesor Motorola Dragonball vz
33MHZ serta 16MB Mask ROM,
16MB SDRAM, dan Flash memory
sebesar 4MB.

“Smartphone ini dapat
memuaskan pengguna yang
cenderung menyimpan banyak
data”, tegas David A. Kong,
Presiden Fifth Media Divisi
regional.

“Ponsel serba bisa
yang istimewa”,

mungkin pendapat itu
yang terlintas dalam
benak orang-orang

yang pertama kali
melihat sosok Xplore

G18. Smartphone
yang dipasarkan oleh

Fifth Media Interna-
tional ini memiliki

fungsi sebagai alat
komunikasi sekaligus
PDA (Personal Digital

Assistant).

plore G18 juga
berfungsi sebagai
middleware yang bisa
menghubungkan

berbagai macam aplikasi yang
terhubung dalam jaringan.
Smartphone ini juga dilengkapi
dengan kemampuan multime-
dia, bisa mengintegrasi fungsi
PIM (Personal Information
Management) dan fitur
telephony. Peluncurannya
memberi nuansa baru bagi
pasar teknologi mobile di
Indonesia.

Tren teknologi saat ini
memang mengarah ke
produk yang sifatnya all-in-one,
satu benda dengan banyak
fungsi. Batasan antara
smartphone dengan PDA juga
semakin kabur. Coba
bandingkan antara teknologi
PDA yang berfungsi sebagai
smartphone dengan
smartphone yang berfungsi
sebagai PDA, adakah perbedaan
yang jelas?

MUNGIL, SEGENGGAMAN
TANGAN

Dari segi fisik, Xplore G18
bisa dikatakan cukup istimewa.
Ukurannya hanya segenggaman
tangan, seukuran dengan posel-
ponsel keluaran baru yang
mungil. Dimensinya berukuran
48 x 100 x 21 mm dan beratnya
105 gr.

Baterai yang digunakan
adalah 850 mAH Lithium-
Polymer seberat 19 gr. Waktu
bicaranya 2 jam dan memiliki

Xplore G18 merupakan
kombinasi teknologi telepon
bergerak dan PDA yang
menawarkan fitur lebih dari
sebuah PDA biasa.

Kamera digital yang
terintegrasi di dalamnya
beresolusi 352 x 288 pixel, dan
memiliki dua mode gambar – B/W
(hitam putih) dan berwarna.
Dengan 2x digital zoom, besar
resolusi yang bisa ditangkap
adalah 320 x 240, 80 x 60, 160 x
160, dan 160 x 200. Kamera ini
juga dilengkapi dengan software
untuk editing foto dan gambar.

Xplore G18 dilengkapi
dengan browser WAP (Wireless
Application Protocol) 1.2.1 dan
WML (Wireless Markup Lan-
guage) 1.2.1 yang mendukung
koneksi ke Internet melalui WAP
Gateway dan jenis bearer UDP
seperti CSD dan GPRS. Dengan
teknologi tersebut, pengguna
bisa mendownload melodi,
gambar, e-book
dan jenis-jenis file
PRC dan PDB
lainnya. Antarmuka
yang user-
friendly
memungkinkan
pengguna
untuk
mengatur
seting dan
konfigurasi
browser sesuai
keinginannya.

Konektivitas
merupakan
kunci dari
keberhasilan
komunikasi.
Untuk
mendukung
konektivitasnya,

Big Money, dan
Zap 2000.

Satu lagi kelebihan dari
Xplore G18, smartphone ini
dilengkapi dengan fitur Al
Qur’an.  Selain itu, perangkat
ini bisa menunjukkan arah
kiblat.

Dengan harga jual Rp
4.180.000,-, Fifth Media
membidik target pasar
menengah ke atas. Produk ini
sudah dipasarkan sejak bulan
Oktober 2003. Sama dengan
semua produk elektronik, untuk
layanan purna jualnya, Fifth
Media memberikan garansi dan
jaminan servis selama 12 bulan
sejak tanggal pembelian Xplore
G18. Untuk distribusinya, Fifth
Media memfokuskan pada 5
kota besar di Indonesia –
Jakarta, Bandung, Semarang,
Surabaya, dan Medan.
Sedangkan untuk hotline
center-nya bertempat di kantor
Fifth Media di Menara Kebon
Sirih, Jakarta. PC+
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Xplore G18 juga
dilengkapi dengan
IrDA (Infrared Data
Association), kabel
PC-sync, dan antena
dual band eksternal
sepanjang 20mm.
Perangkat mungil ini
mendukung aplikasi
Java dan layanan e-
book, e-mail, SMS
(Short Message
Service) dan MMS
(Multimedia Message
Service). Fitur orga-
nizer-nya dilengkapi
dengan buku alamat,
date book untuk
menyimpan jadwal
kegiatan, memo, dan
to-do list.

Buku alamatnya bisa
dilengkapi dengan attachment
foto dan reminder tanggal ulang
tahun. Foto penelpon yang
tersimpan pada buku alamat bisa
ditampilkan pada saat telepon

masuk.
Untuk

alert-nya,
Xplore G18
memiliki
dynamic
receiver dan
micro speaker
sebesar 13mm
yang
mendukung
suara melodi
dan nada
getar.
Smartphone
ini memiliki 32
nada dering
polifonik yang

setingnya bisa
diatur sendiri. Game-game

yang tersedia adalah Bejeweled,
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Sony Ericsson T230
adalah ponsel yang

menghibur. Ponsel ini
akan ikut

meramaikan pasar
ponsel Indonesia

mulai pertengahan
bulan November ini.

Dengan teknologi
GSM/GPRS, T230

mendukung semua
aplikasi komunikasi
dan hiburan terkini.

ony Ericsson
sebagai salah satu
pionir dalam pasar
ponsel GSM dengan

layar berwarna, sudah pasti
dikenal oleh masyarakat Indo-
nesia. Dengan adanya T230
yang lengkap dengan aplikasi
imaging, gambar dan hiburan,
dan ditujukan bagi konsumen
low-end, tampaknya posisi
Sony Ericsson di pasar ponsel
akan semakin kuat.

Dimensinya cukup kecil,
101 x 44 x 19 mm, dengan
berat kurang dari 80 gram,
sudah termasuk baterai.
Baterai yang digunakan
adalah Standard Battery BST-
30 (680mAh Li-ion). Ada dua
pilihan warna, yaitu Steel Blue
dan Blade Grey. Tipe layarnya
adalah Full Graphic LCD 4.096
warna, memiliki ukuran 34 x
24 mm dan resolusi 101 x 80
pixel. Layar ini menampilkan
backlight display. Dengan
4.096 tampilan warna,
pengguna T230 bisa
menggunakan gambar
berwarna mau pun grafik
untuk mengekspresikan
personalisasi ponselnya, baik
untuk tema, wallpaper, games
atau pun content lainnya.

FITUR YANG ASYIK
Sony Ericsson T230

berjalan pada jaringan selular
GSM 900MHz/1800MHz.
Phonebook-nya dapat
menyimpan hingga 510 nama.
Fitur-fitur yang disediakan
dalam ponsel ini antara lain
adalah picture gallery, picture
wallpaper, picture phonebook,
32 nada dering polifonik, dan
melody composer, sleep mode,
speed dialing dan vibrating
alert. T230 juga mendukung
fungsi organizer (kalender,
kalkulator, alarm, dan jam),
SMS, EMS, MMS, dan e-mail.

Ponsel ini dilengkapi
dengan browser WAP 1.2.1
WTLS Class 2 dan teknologi
GPRS yang untuk mendukung
koneksi ke Internet. Dengan
GPRS berkecepatan tinggi
lebih dari 53,6 Kbps, pengguna
bisa melakukan jelajah mobile
Internet yang efektif.
Pengiriman e-mail dan
download dokumen bisa
berlangsung lebih cepat.

Ada beberapa game
dalam T230, di antaranya
adalah V-rally dan Dep Abyss.
Ada lima arah navigation key
yang fungsinya selain untuk
mempermudah pengoperasian

Sony Ericsson T230:
Ponsel yang”Full Entertainment”

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

dan akses menu pada ponsel,
juga untuk mendukung
permainan mobile game di
dalamnya. Sama seperti ponsel
Sony Ericsson lainnya, seperti
T300, T310 dan T610, T230 juga
diaplikasikan pada platform
Mophun. Bagi para pecinta
mobile gaming, T230
menampilkan game yang
berwarna. Jika ingin menambah
game dan level baru, mereka bisa
mendownload-nya dari

www.sonyericsson.com atau
situs-situs lainnya. Dengan ada-
nya efek vibrasi dan sound feed-
back, pengguna bisa mendapat-
kan pengalaman bermain yang
sangat menyenangkan.

AKSESORIS KAMERA
T230 bisa digunakan dengan

aksesoris kamera digital clip-on
MCA-30 CommuniCam VGA.
Dengan penambahan perangkat
ini, T230 bisa dipakai untuk

mengambil, menampilkan dan
mengirim gambar dengan
menggunakan layarnya sebagai
viewfinder. Gambar tersebut bisa
dikirim sebagai e-mail ke
komputer atau sebagai MMS ke
pengguna ponsel lainnya. Bebe-
rapa slide yang berisi gambar, fun
layer, suara dan teks bisa dikirim
sekaligus sebagai satu pesan.

Bagaimana dengan
harganya? Karena targetnya
adalah segmen pasar low-end,

S

harga yang ditawarkan juga
cukup terjangkau. Menurut
pihak Sony Ericsson, mereka
akan menjual T230 dengan
harga di bawah Rp 2 juta. PC+

ISTIMEWA
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Data File Management pada
Microsoft Outlook

Meringkas Secara Otomatis
pada Word dengan
AutoSummarize

Easter Egg pada
Ahead Nero 5

ANDAIKAN, Anda memiliki tiga
sistem operasi dalam 1 PC,
Windows 98, 2000 dan Windows
XP. Kemudian pada ketiga
sistem operasi tersebut Anda
meng-install Microsoft Out-
look dan menjadikannya
sebagai e-mail client.
Dengan kondisi tadi sebagian
besar orang hanya
menggunakan salah satu dari
ketiga sistem operasi tadi
sebagai sistem operasi utama
yang digunakan untuk
mengelola e-mail.

Agar lebih praktis, mungkin
nggak sih kalau ketiga sistem
operasi tadi dijadikan “sistem
operasi utama” sehingga dapat
digunakan untuk membaca dan
mengelola e-mail yang sama?
Jawabannya, bisa! Jadi, dari
sistem operasi manapun Anda
mendownload e-mail, e-mail
tersebut tetap dapat dibaca
dengan sistem operasi lain. Hal
ini mungkin terjadi karena
Anda dapat memasukkan satu
file data e-mail utama yang
Anda miliki ke dalam daftar
Data File Management di
Microsoft Outlook. Dengan
begini, maka dari manapun
Anda mendownload e-mail,
data e-mail yang Anda miliki
akan disimpan pada file data
yang sama.

Bagaimana cara mengatur
Data File Management milik
Outlook ini? Ikuti langkah-
langkah berikut ini.
1. Klik [Start]>[All

Programs]>[Microsoft
Office]>[Microsoft Outlook]
untuk menjalankan
Microsoft Outlook.

2. Pada program Microsoft
Outlook klik [File]>[Data File
Management...].

3. Akan muncul window
Outlook Data Files. Pada
bagian bawah window
terdapat nama file dan di
mana lokasi file data berada.

4. Untuk menambahkan file
data baru, klik [Add...].

5. Pilih [Personal Data Files
(.pst)], lalu klik [OK]. Pada
Microsoft Office Outlook 2003
terdapat sedikit
ketidakkompatibelan file data
dengan Outlook XP dan versi-
versi sebelumnya. Letak
perbedaannya, pada file .pst
Outlook 2003 mampu untuk
menyimpan lebih banyak e-
mail dan folder, serta
mendukung multilingual
Unicode data.

6. Selanjutnya akan muncul
Create or Open Outlook
Data Files. Carilah file .pst
yang Anda miliki di drive lain
atau ketikkan nama file yang

diinginkan jika Anda ingin
membuat file .pst baru, lalu
klik [OK].

7. Langkah berikutnya akan
muncul Create Microsoft
Personal Folders. Isikan
nama folder yang Anda
inginkan pada bagian Name:,
dan jika Anda ingin
memasang password pada
data isikan password tersebut
pada kolom yang sudah
disediakan, kemudian klik
[OK] sekali lagi.

8. File data yang baru Anda buat
atau pilih akan ditambahkan
ke dalam daftar di Outlook
Data Files.

9. Jika sewaktu-waktu Anda
ingin mengubah nama folder
dan password, Anda dapat
mengklik tombol [Settings...].
Disana juga terdapat fitur
untuk memperkecil ukuran
personal folder file dengan
mengklik [Compact now].

10. Apabila Anda tidak ingin lagi
agar file data yang berisi e-
mail Anda tadi dikenali oleh
Outlook, Anda dapat
mengklik [Remove] dan
kemudian klik [Yes] saat
muncul konfirmasi. Proses
remove disini hanya
menghilangkan nama file

Anda dari daftar, bukan
untuk menghapus file data
yang sudah Anda miliki.
Jadi, data Anda tidak akan
hilang hanya dengan meng-
klik tombol [Remove] ini.

11. Setelah selesai mengatur
management data, klik
[Close].
Ada satu yang perlu

diperhatikan. Jika Anda
memiliki harddisk, katakanlah
dengan partisi FAT32 dan NTFS,
kemudian file data Anda
diletakkan di NTFS maka sistem
operasi Windows 9x/Me yang
berada di FAT32 tidak akan
mampu membaca file di NTFS.

Steven Andy Pascal
steven@e-pcplus.com

SEPERTI EDISI LALU, minggu ini kita masih bicara seputar easter
egg. Kali ini yang kita bahas adalah easter egg pada Ahead Nero 5.
Anda tau siapa saja yang berada di balik pembuatan software
burning CD/DVD ini? Ikuti langkah-langkah berikut ini:
1. Klik [Start]>[All Programs]>[Ahead Nero]>[Nero – Burning

ROM] untuk menjalankan Nero.
2. Klik [Help]>[About Nero – Burning ROM].
3. Ketika window About Nero – Burning ROM terbuka, klik dua

kali pada jendela tersebut. Pada bagian bawahnya akan muncul
nama-nama programmer yang turut berperan serta dalam
pembuatan program.

4. Setiap kali Anda mengklik ganda window tersebut maka animasi
nama-nama dari programmer yang muncul akan berubah.
Terdapat empat macam animasi di sana. Selamat mencoba.

Steven Andy Pascal
steven@e-pcplus.com

PADA MICROSOFT WORD,
Anda dapat membuat ringkasan
dokumen secara otomatis. Hal
ini dimungkinkan dengan
adanya feature
AutoSummarize.

Caranya, buka sebuah
dokumen lalu pilih [Tools]
kemudian klik
[AutoSummarize]. Setelah
kotak AutoSummarize terbuka,
pilih jenis ringkasan yang ingin
Anda pakai.

Ada 4 pilihan ringkasan, yaitu:
1. Memberikan highlight pada

dokumen.
2. Membuat ringkasan atau

abstrak pada bagian atas dari
dokumen.

3. Membuat dokumen baru
yang berisi ringkasan.

4. Menampilkan ringkasan pada
dokumen dan menyembunyi-
kan bagian lainnya tanpa
menutup dokumen tersebut.

Kemudian pada box
[Percent of original] ketik atau
pilih persentase ringkasan yang
diinginkan terhadap dokumen.
Perhatikan, bahwa sangat tidak
mungkin Word membuat
ringkasan persis seperti yang
Anda butuhkan, Anda masih
perlu menyunting kembali
ringkasan tersebut.

Weldy Rahman
wrnazmi@yahoo.com



plusTrik

| 11

IV • 11 - 17 November 2003
PCplus 152

Install Font Berekstensi TTF
pada Linux Redhat 9.0

Sistem Keamanan Menyeluruh
Microsoft Excel Tanpa Program Lain

DENGAN MENGGUNAKAN
sistem operasi Windows 9x
ataupun Windows XP, sebagian
besar kegiatan yang Anda
lakukan selalu berhubungan
dengan interface grafis yang
sangat user friendly. Hampir
tidak ada script ataupun
perintah-perintah tertentu yang
mesti Anda jalankan untuk
melakukan konfigurasi ataupun
penginstalan suatu program.
Lain halnya jika Anda
menggunakan Linux RedHat 9.0
meskipun telah dilengkapi
dengan X-Windows yang
menghasilkan tampilan grafis
yang nyaris menyaingi Windows
XP namun untuk beberapa hal
tertentu Anda tidak selamanya
dapat menggunakan interface
grafis ini.

Salah satu aktivitas yang
dimaksud adalah penginstalan
font, meskipun pada distro
Linux lain seperti Mandrake
9.01 Anda dapat melakukan
penginstalan font dengan
mudah seperti di Windows.

Namun untuk Linux RedHat,
penginstalan font terutama yang
berekstensi .ttf memerlukan cara
yang sedikit lebih rumit.

Trik kali ini lebih terfokus
pada penginstalan font
berekstensi .ttf dikarenakan agar
bagi Anda yang sebelumnya
telah memiliki font yang
digunakan oleh OS Windows
tersebut, tidak perlu lagi mencari
font-font untuk Linux. Sekalian
juga untuk membuktikan bahwa
bukanlah suatu hal yang mustahil
Windows dapat bergandengan
tangan dengan Linux. Untuk
melakukan trik tersebut ikuti
langkah-langkah berikut:
• Login sebagai root.
• Buat folder baru untuk

menyimpan font berekstensi
.ttf tersebut. Misalkan saja
pada trik ini penulis
menggunakan direktori /usr/
local/fonts/ttfont.

• Buka file config yang terletak
pada direktori /usr/X11R6/lib/
X11/fs dengan program
editor teks seperti vi, kwrite,

emacs, dan sebagainya.
• Ketikkan path folder yang

telah Anda buat pada
langkah pertama pada bagian
line terakhir dari “catalogue
=”. Sebelum menuliskan path
tersebut, berikan terlebih
dahulu tanda koma pada path
di line sebelumnya.

• Buka terminal dan arahkan
prompt shell menuju folder
tempat penyimpanan font
berekstensi .ttf yang telah
Anda buat pada langkah
pertama dengan perintah cd.
Untuk trik kali ini perintah
yang dituliskan adalah cd /
usr/local/fonts/ttfont

• Ketikkan perintah ttmkfdir >
fonts.scale mkfontdir.

Sampai di sini proses
penginstalan telah Anda lakukan,
dan font .ttf telah dapat Anda
gunakan. Namun perlu diketahui,
font berekstensi .ttf ini menurut
pengamatan penulis hanya dapat
dikenali oleh program
OpenOffice.org dan The GIMP.

Hal ini sebenarnya tidak terlalu
berpengaruh karena aktivitas
yang selalu berkaitan dengan va-
riasi font lebih banyak tercakup
pada kedua program tersebut.

Proses penginstalan sudah
Anda ketahui. Nah bagaimana
jika Anda ingin menambah font
baru ataupun melakukan
uninstall terhadap font tersebut.
Untuk menambah font baru
Anda hanya perlu meng-copy file
font tersebut pada folder di atas,

dan mengetikkan perintah yang
disebutkan pada langkah ke-5
dan 6. Kemudian untuk meng-
unistall font tersebut, Anda
hapus file font berekstensi .ttf
tersebut dan ketikkan juga
perintah pada langkah ke -5
dan 6. Kedua aktivitas terakhir
ini tentunya dapat dilakukan
jika Anda login sebagai root.

Arif Perdana
mail_id_2001@yahoo.com

MUNGKIN UNTUK
MEMROTEKSI data yang begitu
rahasia Anda harus
menggunakan program
tertentu. Namun biasanya
untuk membuka data itu
nantinya program proteksi tadi
harus sudah terinstal lebih
dahulu pada komputer di mana
Anda ingin membuka data
tersebut. Jika Anda tidak
memiliki atau belum memiliki
program tersendiri yang
digunakan sebagai proteksi
maka coba simak artikel ini
kemudian rasakan bedanya.

Excel menawarkan begitu
banyak cara untuk melindungi
data Anda. Tapi dengan
kelebihan dan kekurangan
masing–masing, cara tersebut
cukup membuat kita menjadi
bingung. Berikut ini akan coba
penulis jelaskan 4 (empat)
metode untuk melindungi data
yang Anda anggap top secret
sehingga untuk “sementara”
betul-betul aman dari incaran
orang lain.
1. Worksheet dan Cell Protec-

tion
Setiap cell memiliki dua
sistem kemananan, Locked
(mengunci) dan Hidden
(sembunyi). Locked cell
akan melindungi cell dari
perubahan sedangkan
Hidden Cell akan
menyembunyikan isi cell dari
tampilan pada formula bar

ketika cell tersebut diaktifkan.
Setiap cell secara default
sudah di-locked dan belum di
hidden, namun dua atribut ini
baru bisa aktif jika proteksi
worksheet dijalankan. Untuk
mengaktifkan locked dan
hidden cell, blok cell yang
ingin Anda lindungi, klik
[Format]>[Cells]>[Protection],
aktifkan tanda centang
[Locked] dan [Hidden].
Kemudian jalankan proteksi
worksheet, dengan mengklik
[Tools]>[Protection]>[Protect
worksheet]. Aktifkan seluruh
tanda centang pilihan atau
pilih sesuai kebutuhan Anda.
Isikan password agar orang
lain tidak bisa menonaktifkan
worksheet protection. Klik
[OK], dan masukkan lagi
passsord konfirmasi, lalu klik
[OK].
Sekarang seluruh sel yang
Anda blok tadi tidak akan
bisa diedit, dilihat
formulanya, ditambah baris
atau kolomnya dan lain-lain.
Tapi dalam kondisi tertentu
jika Anda ingin dalam
worksheet Anda ada
beberapa cell yang bisa
diubah, maka sebelum
mengaktifkan worksheet
protection blok atau pilih cell
untuk input data tersebut,
lalu klik
[Format]>[Cells]>[Protection]
dan hilangkan tanda centang

[Locked], kemudian baru
jalankan proteksi worksheet.
Sekarang pada cell input data
Anda atau orang lain bisa
memasukkan data namun cell
formula dan yang lainnya
tetap aman.

2. Workbook Protection.
Pilihan ini dapat melindungi
workbook dari perubahan,
penambahan atau
pengurangan sheet, juga
ukuran jendela dari work-
book, caranya klik
[Tools]>[Protection]>[Protect
Workbook], pilih tanda
centang sesuai kebutuhan
Anda, masukkan password
agar lebih aman.

3. Proteksi File
Berikut ini cara yang
digunakan untuk
memproteksi file Anda dan
jika Anda atau orang lain
ingin membukanya dan
mengeditnya, harus terlebih
dahulu memasukkan pass-
word.

• Pada Excel 97, klik
[File]>[Save As] untuk
menampilkan kotak Save As.
Klik [Options] lalu masukkan
password. Klik [OK], masuk-
kan password konfirmasi
kemudian klik [OK] sekali lagi.

• Pada Excel 2000 dan 2002, klik
[File]>[Save
As]>[Tools]>[General
Options]>masukkan
password>[OK]>masukkan

password konfimasi>[OK].
4. Proteksi VBA

Jika berada di dalam work-
book Anda mempunyai macro
(VBA macro), Anda bisa
melindungi kode macro dari
orang lain yang ingin
melihatnya dengan cara
menekan [Alt]+[F11] untuk
mengaktifkan jendela editor
VBA. Klik [Project] pada
jendela Project, klik
[Tools]>[VBA Project
Properties]>[Protection]>aktifkan
tanda centang pada [Lock
Project for
viewing]>masukkan
password>password yang
sama untuk
konfirmasi>[OK].
Semua hal di atas dapat

Anda lakukan sekaligus atau
sesuai dengan pilihan Anda. Jika

dibutuhkan, mungkin Anda
juga ingin menyembunyikan
kolom dan baris pada
worksheet, untuk langkah ini
silakan lihat kembali PCplus
edisi 144.

Namun sebagai catatan,
apapun cara yang Anda tempuh
untuk melindungi data Anda
baik itu dengan program
tersendiri atau Excel, ini hanya
akan memperlambat jalan bagi
para hacker atau cracker
mendapatkan data Anda,
sekarang ini begitu banyak
program password cracking
diproduksi dan juga mereka
selalu mencari cara terbaru
untuk menaklukkan benteng
yang Anda bangun.
Waspadalah....!

Budiman
ibnu_78@yahoo.com
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Galeri Uji
Pencetakan Foto

Alex Pangestu
alex@e-pcplus.com

S

Alphons Mardjono
alphons@e-pcplus.com

Masih berhubungan
dengan plusFokus edisi

minggu lalu yang
membahas

pengoptimalan hasil
cetak foto digital,

plusUji kali ini
menampilkan hasil-

hasil cetak foto digital
dari beberapa printer.

eperti kamera
digital, printer pun
memiliki perbedaan
karakter dalam

mencetak. Ada beberapa printer
yang menonjolkan kontras
warna, sedangkan yang lainnya
menonjolkan kenaturalan. Di
samping printer itu sendiri,

penggunaan kertas pun
mempengaruhi hasil cetakan.
Tidak hanya perbedaan jenis
kertas, tapi juga merek kertas.
Jenis kertas yang sama namun
berbeda merek digunakan pada
printer yang sama, hasilnya
belum tentu sama.

PCplus menggunakan foto
seorang model yang berpose
bersama color checker. Foto
diambil dengan menggunakan
kamera Minolta DiMAGE 7i.
Penggunaan model dimaksudkan
untuk melihat bagaimana printer

mampu menghasilkan warna
kulit (skin tone) yang sesuai.
Sedangkan penggunaan color
checker dimaksudkan untuk
melihat penyimpangan warna-
warna primer dan beberapa
warna sekunder, serta
penyimpangan white balance.
Perlu diperhatikan, bahwa skin
tone ini juga dipengaruhi oleh
kamera digital. Dus, dengan
menggunakan kamera digital
yang berbeda akan dihasilkan
skin tone yang berbeda. Untuk
itu PCplus hanya menggunakan

sebuah kamera digital.
Untuk mencetak, PCplus

menggunakan printer dan kertas
foto yang beragam. Printer yang
PCplus gunakan adalah HP
Photosmart 7260, Canon XNU
i255, dan HiTi PhotoShuttle.
Kertas foto yang digunakan
adalah HP Colourfast Photo Paper
Glossy, Mitsubishi Photopaper,
Canon Paper Plus Glossy PP-101,
dan Tetenal Premium Fine Art
Glossy untuk printer Canon dan
HP (perhatikan caption foto
untuk mengetahui jenis kertas

yang digunakan untuk
mencetak).

Untuk printer HiTi Photo-
Shuttle, PCplus hanya mengguna-
kan kertas foto bawaannya.
Alasannya adalah penggunaan
kertas yang bukan bawaannya
akan menghasilkan gambar yang
benar-benar jauh dari aslinya,
dan bahkan bisa merusak printer
ini.

Mengingat keterbatasan
cetakan PCplus yang
menggunakan kertas HVS,
beberapa perbedaan mungkin

CANON XNU i255 :
Printer Canon XNU i255 memiliki karakter menampilkan kontras warna. Warna-warna hasil cetakan tampil dengan cerah. Pada beberapa bagian dari gambar muncul sedikit warna
magenta. Jika pada foto-foto di bawah, warna magenta muncul di bagian bayangan (shadow). Penggunaan kertas yang bukan merek Canon menyebabkan warna pada gambar menjadi
menyimpang. Penyimpangan itu adalah gambar yang kekuning-kuningan.

Canon Paper Plus Glossy PP-101 HVS Paper One 70 gr Tetenal Premium Fine Art Glossy 290 gr Mitsubishi Photo Paper

HP Colourfast Photo Paper Glossy HVS Paper One 70 gr Tetenal Premium Fine Art Glossy 290 gr Mitsubishi Photo Paper

HP PHOTOSMART 7260 :
Karakter printer HP ini berbeda dengan printer Canon XNU i255. Apabila printer Canon XNU i255 cenderung memunculkan warna magenta, HP Photosmart 7260 cenderung
memunculkan warna cyan. Kecenderungan itu muncul di beberapa tempat pada hasil cetakan, tidak hanya di bagiah shadow. Penggunaan kertas yang bukan merek HP juga
menyebabkan hal yang sama pada printer Canon, yaitu gambar yang kekuning-kuningan.

Model:TANTI

Foto:ALEX/PCplus
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HiTi PHOTOSHUTTLE :
Printer ini sangat Eksklusif. Mengapa? Hanya kertas HiTi saja yang bisa digunakan
untuk mencetak dengan printer ini. Penggunaan kertas yang sembarangan akan
menyebabkan hasil cetakan yang sangat menyimpang, bahkan bisa merusak printer.
Printer ini memiliki kecenderungan untuk menampilkan warna yang natural.

HiTi Photo Paper HiTi Photo Paper

FOTO LAIN

Dua foto di atas adalah dua foto lain yang juga PCplus cetak untuk pengujian hasil
cetakan. Foto di sebelah kiri dicetak menggunakan printer Canon XNU i255 dengan
kertas Canon Paper Plus Glossy PP-101. Sedangkan foto di sebelahnya dicetak
menggunakan printer HP Photosmart 7260 dengan kertas HP Colourfast Photo Paper
Glossy.

tidak terlihat secara signifikan
(apabila Anda menginginkan
semua file digital, silakan
menghubungi alamat e-mail di
atas). Sebagai informasi, semua
foto yang dicetak tidak menga-
lami manipulasi oleh software
apa pun di PC. Software yang
digunakan sebagai sarana
“numpang lewat” adalah
Windows Picture and Fax Viewer

bawaan Windows XP. Masing-
masing printer di-setting pada
pengaturan yang paling baik.

Pada plusFokus edisi lalu,
PCplus menyebutkan bahwa
sebuah merek printer lebih baik
digunakan bersama dengan
kertas foto merek mereka.

PCplus membuktikannya
pada plusUji kali ini. Dengan
menggunakan kertas foto

Mitsubishi pada printer Canon
maupun HP, warna yang
dihasilkan tidak natural. PCplus
mendapatkan hasil cetakan yang
kekuning-kuningan. Penyimpang-
an ini cukup signifikan.

Hal yang sama juga muncul
pada saat menggunakan kertas
foto Tetenal walaupun tidak
sesignifikan kertas foto
Mitsubishi. Jadi bukan sekadar

jualan belaka jika para produsen
printer menyebutkan  bahwa
lebih baik menggunakan printer
mereka daripada merek lain.

Penggunaan kertas HVS
biasa mengurangi detail foto.
Hasil pengujian PCplus juga
membuktikannya.

Daya serap kertas HVS biasa
yang lebih tinggi daripada kertas
foto yang menyebabkan

hilangnya detail karena tinta
menyebar melalui pori-pori
kertas.

Lain kali, PCplus akan
membahas bagaimana
memperbaiki foto yang tidak
sesuai keinginan, seperti apa
yang kita lihat di monitor
berbeda dengan apa yang kita
cetak karena karakter printer
yang berbeda-beda. PC+
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Buat Window
Menjadi Transparan

Koreksi File HTML
HTML-Optimizer Pro

Tambah Akord di
Lirik Lagu

ChorderNoteAlphaXP Lite

Window-window dari berbagai software yang sedang dibuka bisa dibuat
transparan dengan memainkan alpha-nya. Software yang bisa melakukan itu adalah
AlphaXP Lite. Freeware yang berukuran 409KB ini bisa di-download dari
www.zeroherosoftware.com.

AlphaXP Lite menyediakan shortcut untuk membuat suatu window menjadi
transparan. Secara default, tombolnya adalah [Ctrl]+[Shift]+[1…9]. Tombol angka di
akhir shortcut berfungsi untuk mengatur tingkat transparansinya. Semakin besar
angkanya, semakin transparan window-nya. Kombinasi shortcut ini bisa diganti
walaupun terbatas. Tombol yang bisa digunakan sebagai tombol pertama dan ke dua
adalah [Alt], [Ctrl], atau [Shift]. Sedangkan tombol ke tiga hanya bisa menggunakan
[1…9] atau [F1…F12].

Fungsi AlphaXP Lite yang lain adalah membuat taskbar menjadi transparan.
Tingkat transparansinya bisa disesuaikan dengan keinginan penggunanya. Dan
asyiknya lagi, taskbar yang transparan itu akan muncul lagi dengan mulus apabila
pointer mouse berada di atas tempat taskbar.

AlphaXP Lite ini merupakan versi ringkas dari AlphaXP. AlphaXP tidak bisa
didownload diberikan gratis, namun AlphaXP memiliki fungsi-fungsi yang lebih
lengkap seperti adanya kemampuan untuk membuat tooltip dan tombol transparan,
pengaturan kecepatan munculnya taskbar, dan fungsi-fungsi lain.

Alex Pangestu
alex@e-pcplus.com

Menambah akord pada lirik lagu memang pekerjaan mudah.
Dengan software pengolah kata paling sederhana pun bisa digunakan. ChorderNote
membuat pekerjaan yang sudah mudah itu menjadi semakin mudah. Kita tidak perlu
lagi mengetik akord-akord secara manual, tapi hanya dengan mengklik tombol-tombol.
Misalnya untuk mengetik akord C#m7, dengan ChorderNote hanya perlu mengklik
sebuah tombol.

Ada 2 buah tipe akord yang ditampilkan, yaitu tipe plain dan chord pro. Tipe plain
menuliskan akord di atas lirik, sedangkan tipe chord pro menuliskan akor dengan
disisipkan di antara lirik dalam satu baris. Sebenarnya ada satu tipe lagi, tapi masih
termasuk tipe chord pro, yaitu spaced chord pro. Bedanya dengan chord pro adalah
adanya spasi di sisi kiri dan kanan akord yang disisipkan.

Cara menggunakan ChorderNote ini sangat mudah. Kita tinggal membuka atau
mem-paste lirik yang akan ditambahkan akordnya. Klik di mana akord akan

ditampilkan. Kemudian
pilih akord yang hendak
ditampilkan. Kalau tidak
ada di tombol akord-akord,
kita bisa menambahkan
akord yang kita buat
sendiri. Hasilnya bisa
disimpan, dicetak, bahkan
keduanya. Fitur lainnya
adalah pemilihan font,
baik font untuk teks
maupun font untuk akord.

ChorderNote yang
berukuran 116KB dapat
diperoleh dari
members.fortunecity.com/
jimbits/chorder.html.
Lisensinya freeware.

Alex Pangestu
alex@e-pcplus.com

Sintaks HTML yang tidak benar akan memperlambat browser
untuk menampilkan suatu halaman karena browser akan mengecek kebenaran tag.
Oleh karena itu, diperlukan cara untuk memeriksa tag-tag sebelum situs di-launching.

Namun jika situs Web Anda mempunyai halaman yang banyak, yang terdiri dari
belasan file HTML, haruskah Anda mengecek tag per file? Bayangkan berapa lama
waktu yang dibutuhkan.

Untuk itu diperlukan software yang mampu mengoptimasi tag HTML dengan sekali
jalan. Selain format HTML juga hampir semua format file situs web seperti php, asp, jsp,
atau yang lain juga di-support. Contoh software yang bisa digunakan ialah HTML-
Optimizer Pro yang dapat didownload di www.tonbrand.nl.

Cara kerja tool ini ialah mengecek penggunaan tag. Misalnya terdapat penulisan
atribut yang salah. Contohnya adalah <a href =”http:naskah@e-
pcplus.com”>Naskah</a>. Sintaks itu salah. Sintaks yang benar adalah

<a href =”mailto:naskah@e-pcplus.com”>Naskah</a>.
Sebagai persiapan sebaiknya letakkan file-file situs Web Anda dalam satu folder. Ini

dimaksudkan supaya HTML-
Optimizer Pro dapat lebih
optimal melakukan kerjanya.
Pertama kali software
dijalankan, cari folder situs
Web Anda sebagai direktori
kerja. Setelah itu klik [Start]
dan lihat hasilnya.

Dengan HTML-Optimizer
Pro, Anda dapat melihat be-
rapa persen tingkat kesalahan
masing-masing file. Nah,
dengan cara di atas maka situs
Web Anda akan tampil dengan
optimal, dan tentunya makin
sempurna. Selamat mencoba!

M Syafii
karebet_asli@telkom.net

Editor Teks Ringan
Kaya Fitur

Metapad

Notepad dirancang sebagai text editor yang menggunakan memori seminimal
mungkin, dan mudah dalam penggunaannya. Tapi sayangnya, text editor bawaan
Windows ini mempunyai fasilitas yang juga sangat minimum.

Bagi Anda yang menginginkan text editor ringan yang memiliki fitur lebih
banyak dari Notepad, cobalah Metapad. Text editor ini memunyai fasilitas-fasilitas
tambahan yang membantu memudahkan pengeditan file teks.

Sebagai contoh, Anda
dapat dengan mudah
mengatur penggunaan huruf
kapital atau non-kapital dalam
sebuah kalimat. Pengaturan
bisa berupa letak huruf kapital
atau non-kapital. Misalnya,
letak huruf kapitalnya hanya di
awal kata atau awal kalimat.
Anda juga dapat
menggabungkan beberapa file
teks ke dalam file teks yang
sedang Anda buka dengan
Metapad. Fasilitas drag and
drop juga tersedia.

Apabila Anda ingin
menyimpan file teks dalam format Unix, Anda dapat mengaturnya di tab [Setting].
Salah satu dari fitur Metapad adalah tersedianya fitur plug-in bahasa. Di situs
Metapad, www.liquidninja.com, Anda dapat men-download plug-in untuk
berbagai bahasa, bahkan plug-in untuk Bahasa Indonesia juga tersedia.

Metapad bisa ada dapatkan secara cuma-cuma di www.liquidninja.com/
metapad. Anda bisa menggunakan Metapad tanpa instalasi.

Adi Kurniawan
adiebox@yahoo.com
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Berkirim Pesan di Jaringan
Tonic v1.0.480

Bagi yang biasa
bekerja di dalam suatu
jaringan komputer, Anda pasti
pernah berkirim pesan kepada
rekan kerja di ruangan lain
lewat PC. Entah untuk
menanyakan sesuatu yang
serius tentang perkembangan
pekerjaan kantor atau sekadar
iseng untuk mengusir kantuk.
Untuk keperluan semacam ini,
Windows telah menyediakan
alat bantu yang built-in seperti
NetMeeting. Bahkan untuk
sistem operasi generasi lama
seperti Windows 95 juga
tersedia WinPopup.

Bosan dengan yang sudah
ada atau ingin mencoba yang
lain? Barangkali software
bernama Tonic yang saat ini
sudah mencapai versi 1.0.480
bisa memuaskan, atau setidak-
tidaknya memberi nuansa baru
bagi Anda.

Untuk dapat berkomunikasi
dengan alat bantu ini, Anda
harus terlebih dahulu
melakukan instalasi Tonic pada
PC-PC yang saling terhubung di
jaringan. Begitu sudah diinstal,
Tonic akan otomatis mendeteksi
keberadaan user yang sedang
online. Hal ini bisa diketahui

dari munculnya ikon berikut
nama user pada layar. Tidak
perlu susah-susah mengetikkan
alamat yang hendak dituju.

Jika PC Anda dilengkapi
perangkat audio, proses online/
offline dari user lain maupun
adanya pesan masuk juga bisa
diketahui dari bunyi yang
keluar dari speaker. Suara yang
terdengar bahkan bisa diganti
dengan suara Anda sendiri. Hal
ini dimungkinkan karena untuk
keperluan ini file audio
berformat WAV yang dengan
mudah bisa direkam dengan
fasilitas Sound Recorder dari
Windows.

Beberapa fitur
yang tersedia pada
Tonic antara lain:
• Ikon dan nama

user bisa di-
customize.
Salah satu ciri
khusus Tonic
dibanding
software sejenis
adalah
penggunaan ikon
untuk user. Tonic
telah
menyediakan ikon
berbagai karakter
berjumlah 600-an
lebih. Jumlah
sebesar ini
tentunya sangat
lebih dari cukup.
Dengan adanya
ikon, di samping
nama user tentu membuat
Tonic lebih menarik, selain itu
juga akan memudahkan
mengingat profil setiap user.
Ini berbeda jika petunjuknya
hanya berupa tulisan saja.
Asyiknya lagi nama dan ikon
ternyata bisa diubah-ubah
sesuka hati. Bahkan kalau
perlu wajah Anda juga bisa
nampang disitu.

Tertarik? Begini
caranya. Sediakan file
foto wajah Anda. Buka
dengan software
pengolah gambar yang
mendukung file
berformat ICO. Untuk
keperluan ini Anda
bisa menggunakan
program bernama
Ikon Easel 98
(www.easyapps.com)
yang pernah dimuat
PCplus. Ambil bagian
wajah yang ingin
ditampilkan, setelah
itu simpan dalam
format ICO. Tempatkan
file ini pada folder
Images yang
merupakan subfolder
tempat Anda
menginstal Tonic.
Jalankan Tonic
kemudian buka menu
[System]>[Preferences].
Masuk ke tab [Image].
Kalau tidak ada
masalah, maka ikon
yang Anda buat akan

muncul di situ, bergabung
dengan ikon lain yang sudah
ada.

• Emoticon pada pesan.
Pemakaian emoticon
menjadikan berkirim-kirim
pesan lebih beremosi. Yang
lebih asyik, emoticon-nya ada
yang beranimasi. Anda
bahkan bisa menambahkan
emoticon sendiri. Hal ini
dimungkinkan karena
emoticon tersebut sebenarnya
berupa file animated GIF yang
tersimpan di folder Emotes.
Letak folder ini sama setara
dengan folder Image.
Tentunya untuk membuat file

jenis ini Anda butuh bantuan
software khusus.
Sebagai catatan, jika emoticon

tidak muncul pada pesan yang
diterima dan hanya berupa
kotak kosong, Anda perlu
melakukan
setting pada
Internet Ex-
plorer. Pada
Internet Ex-
plorer masuk
ke [Tools]>
[Internet
Options]. Klik
tab [Ad-
vanced],
pastikan pada
[Show
Pictures] dan
[Play Anima-
tions] sudah
ada tanda cek.

• Dapat
berhubungan
dengan PC
lain pada
jaringan yang
menggunakan
gateway yang berbeda.
Misalnya, PC dengan alamat
IP 192.168.1.x dapat saling
berhubungan dengan
192.168.2.x. Anda cukup
mengetikkan alamat IP yang

Tampilan Tonic v1.0.480

Kotak dialog untuk setting ikon

Berbagai macam emoticon yang tersedia

dituju lewat menu
[User]> [Add]. Cara
lain yang lebih
mudah adalah
dengan klik tombol
kanan mouse pada
layar Tonic. Dari
menu yang muncul,
pilih [Add].

Untuk mengi-
rim pesan dengan
Tonic cukup klik do-
bel pada ikon user
yang dituju. Jika
pesan ingin disam-
paikan kepada
beberapa user
sekaligus caranya
dengan melakukan
blok beberapa user
yang dipilih,
kemudian tekan
tombol [Enter] atau

lewat menu [User]>[Message].
Program LAN messenger

yang menarik ini ternyata

berlisensi freeware. Jika Anda
ingin mencobanya, kunjungi
saja situs www.r2.com.au. File

untuk instalasi berjudul
tonic_v1.0b480.exe, memiliki
ukurannya 1.702 KB.

Sugeng R
fxsugengr@yahoo.com

Salah satu model tampilan pesan yang muncul
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Mudik Produktif
dengan Menjadi

“Inspector Gadget”
Mudik berarti

produktivitas turun
drastis atau malah

nol? Jangan sampai
deh! Tapi masa harus

bawa-bawa PC kita ke
udik?

remis
pertama: Dalam
dunia yang sudah
lelah ini, produktivitas

kita disokong oleh dua pilar
utama: komunikasi dan
informasi. Premis kedua: Selain
ibukota negara, mau tak mau
Jakarta juga merupakan ibu-
kota komunikasi dan informasi
nasional. Jadi kalau ada orang
yang hendak meninggalkan
kota padat dan ruwet ini,
apakah itu berarti dia akan
serta merta remote dari pilar-
pilar produktivitas tersebut?

Ya, mau tak mau harus
dijawab: betul! Tapi bukan
berarti tidak dapat disiasati.
Meski mudik, asal kita tetap
“konek” dengan sumber-sum-
ber informasi dan data, produk-
tivitas bisa diharapkan tetap
pada level puncaknya. Masalah-
nya adalah peranti apa saja
yang bisa digunakan untuk
menjaga hubungan intim kita
dengan informasi dan data
selama kita berada di tempat-
tempat yang bukan habitat kita?

Tentu saja kita tidak akan
mudik bersama PC. Bahkan
mungkin juga tidak sempat
membawa notebook,
mengingat beban mudik
Lebaran suka harus dihitung
dalam ukuran kuintal, bahkan
mungkin ton. Jadi, pilihan yang
paling mungkin adalah gadget,
peranti mungil untuk
mendukung kinerja kita. Dalam
lingkungan yang padat tekno-
logi komunikasi dan informasi,
maka gadget lebih dekat
digambarkan dengan alat-alat
seperti ponsel, PDA, MP3 atau
CD player, notebook, dan
sebagainya. Untuk mendukung
produktivitas dan memenuhi
persyaratan ketat compactness
saat mudik maka rasanya ada

F.X. Bambang Irawan
fbi@e-pcplus.com

dua gadget utama yang paling
sesuai, yaitu PDA dan ponsel.

PDA
Personal Digital Assistant

(PDA), seperti namanya,
merupakan peranti bantu untuk
mengelola data digital yang
akhir-akhir ini menanjak
namanya. Popularitas PDA
membubung karena
berbagai hal seperti:
kemampuan olah
datanya sudah tak
berjarak jauh dengan
PC, metode input
datanya sangat
menyenangkan
karena banyaknya
pilihan, kecepatan
pemrosesan makin
tinggi, dan yang
paling “hot” adalah
konektivitasnya
dengan peranti lain
terutama ponsel,
notebook, dan PC.

Dalam soal
pengolahan data
perkantoran,
mungkin PDA dengan basis
sistem operasi Windows Pocket
PC adalah yang paling banyak
digemari karena jaminan
kompatibilitasnya dengan
aplikasi yang jadi jerohan PC
yang umumnya juga sudah
berbasis Windows. Dengan PDA
berbasis Pocket PC, file Outlook,
Word, Excel, PowerPoint, dan
Internet Explorer dapat diolah di
gadget ini. Tinggal sinkronisasi
antara PDA dengan komputer me-
lalui peranti yang tersedia (baik
kabel data, inframerah, Bluetooth,
atau WiFi), maka file yang
berhubungan dengan kerjaan
atau hiburan bisa dipertukarkan.

Namun, bukan berarti PDA
berbasis sistem operasi Palm tidak

mampu melakukannya. Dengan
aplikasi Documents To Go (terbaru
versi 6.0), maka dokumen-
dokumen Word, Excel, dan Power-
Point bisa diolah pada PDA Palm.
Bahkan oleh Palm dalam beberapa
hal Documents To Go ini diklaim
lebih unggul karena benar-benar
lebih kompatibel dengan doku-
men-dokumen Office pada PC.

Oleh karena kecanggihan
tersebut, saat ini PDA merupakan
icon utama produktivitas karena
dengan menentengnya orang
jadi bak membawa PC ke mana
pun dia pergi. Kemudahan ini
dilanjutkan dengan kemudahan
konektivitas dengan peranti lain
dan dengan jaringan data.
Dalam hal ini PDA juga menjadi
middleware sejati karena
keluwesannya berhubungan
dengan jaringan lain seperti
Internet serta jaringan mobile
data yang makin marak tersedia
bagi pelanggan seluler.

Untuk berhubungan dengan
Internet, PDA bisa memanfaatkan
koneksi yang disediakan untuk
berhubungan dengan PC atau

langsung ke WLAN/Wi-Fi. Atau
bisa juga dilakukan koneksi
(pairing) melalui jaringan GPRS
pada ponsel yang sudah mempu-
nyai kapabilitas sebagai modem
GPRS. Antarmuka koneksi yang
tersedia bisa berupa inframerah,
kabel data, atau Bluetooth.

Untuk keperluan koneksi
langsung ke jaringan GPRS

beberapa PDA juga
bisa dilengkapi
dengan kapabilitas
untuk koneksi ke
jaringan GSM/GPRS
baik built-in maupun
melalui Compact
Flash atau jacket.

Favorit baru para
penggemar gadget
adalah PDA-phone
(PDA yang dipadu
dengan telepon
seluler, atau
sebaliknya) atau
paling tidak
smartphone.

Ipaq, salah satu
merek PDA laris
keluaran HP,

mengampanyekan produk-
produk terbarunya untuk
menjaga produktivitas mudik.
Jajaran PDA yang sempat dicicipi
redaksi adalah Ipaq h1940,
h2210, dan h5500. Ketiganya
mempunyai konektivitas yang
memadai untuk digunakan ber-
mobile ria alias mudik. Ketiganya
memiliki fasilitas koneksi
Bluetooth yang mulai marak
digunakan pada peranti digital
saat ini. Malah Ipaq h5500 sudah
terintegrasi dengan kapabilitas
WLAN.

Sumber komunikasi dan
informasi utama kita saat ini
adalah jaringan Internet. Jadi
kalau bisa nyantol ke sana,
alangkah lebih dimudahkan

keinginan kita untuk tetap
produktif di sela-sela
silaturahmi dengan saudara di
udik.

PONSEL
Bukan cuma ponsel canggih

yang bisa digunakan untuk men-
jaga produktivitas dan kelancar-
an mudik. Pada halaman 18 akan
bisa Anda jumpai beberapa
layanan, fitur, dan fasilitas yang
digeber oleh operator seluler
untuk melayani para pengguna
mereka sepanjang masa “mudik
nasional” di hari Lebaran nanti.

Bahkan ponsel-ponsel yang
belum begitu canggih pun bisa
memanfaatkan content yang
“mudik related” melalui fasilitas
menu browser yang diusung
oleh operator melalui kartunya
masing-masing. Untuk itu, kartu
sudah harus minimal
mempunyai kapasitas 32KB, dan
umumnya limit ini sudah
dilangkahi oleh kartu-kartu di
pasaran. Kalau belum ya
upgrade saja dulu!

Namun mempunyai ponsel
yang lebih canggih tentu ba-
nyak kenikmatan lebihnya. Se-
tidaknya banyak layanan yang
tidak sekadar berbasis teks,
seperti hidangan menu browser,
yang bisa diakses. Mereka yang
beruntung berponsel layar
warna dan ber-GPRS dapat
menikmati fasilitas MMS untuk
berkirim pesan. Bahkan ponsel
yang memorinya besar karena
expandable seperti Nokia 3650
dan 6600 dapat menikmati
layanan baru video streaming.

Syukur-syukur kalau ponsel-
ponsel canggih tersebut bisa
terbeli dengan THR. Namun
kalau tidak, maka saran yang
dapat kami berikan adalah agar
Anda mencermati tawaran-
tawaran khusus para operator
sepanjang musim mudik ini.
Ada tawaran-tawaran menarik
seperti bebas roaming, layanan
offline, atau bagi-bagi peta,
misalnya, yang disediakan oleh
para operator. Bisa jadi gara-
gara tawaran menarik sebuah
operator yang Anda pikir akan
memudahkan hidup di
kampung, Anda berkeputusan
untuk pindah operator
(sepanjang musim mudik)! PC+

P

Ipaq h5500 sudah terintegrasi dengan kapabilitas WLAN,
selain Bluetooth
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Menunggu Booming
MMS di Hari Raya

F.X. Bambang Irawan
fbi@e-pcplus.com

S

Lebaran, Natal, dan
Tahun Baru sekarang
mengukir fenomena

tersendiri. Bukan lagi
kartu ucapan

menumpuk di kantor
pos. Melainkan

fenomena berkirim
pesan melalui ponsel,

baik SMS maupun
MMS.

etiap hari
raya, operator
terpaksa menambah
kapasitas server SMS-

nya. Kalau tidak maka mereka
akan menuai bencana karena
besar kemungkinan server-nya
tak sanggup menanggung
boom pesan singkat yang saling
dikirim oleh pelanggannya.

Kini, pesan itu tak lagi
melulu berujud teks singkat
bernama SMS. Kini, sudah ada
MMS, Multimedia Messaging
Service, pesan melalui ponsel
yang bisa diiringi dengan video
dan audio. Malah, lebaran ini
hampir bisa dipastikan MMS
akan mencetak angka traffic
bombastis. Apalagi kalau bukan
disebabkan oleh kemampuan
lintas operatornya.

Seperti booming yang
terjadi ketika dibuka keran SMS
lintas operator, maka MMS pun
diharapkan akan menikmati
peningkatan penggunaan
dengan dibukanya akses MMS
antara tiga operator: Satelindo,
Excelcom, dan IM3.

MMS (Multimedia Messag-
ing Service) memang asyik.
Siapa yang tak suka berkirim
pesan yang kaya ekspresi?
Hanya saja beberapa kendala
masih menghadang. Pertama-
tama orang dihadang dengan
harga handset yang mempunyai
kemampuan GPRS (General
Packet Radio Switch) dan MMS
masih relatif mahal (sekitar 1,5

juta rupiah ke atas). Setelah itu
masalah keterbatasan layanan
operator masih menjadi kendala.
Masa kita hanya bisa ber-MMS
dengan sesama pengguna
operator yang sama? Masa tidak
bisa mengirim ke nomor dari
operator lain?

Namun, sejak tanggal 23
Oktober lalu, masalah ini teratasi.
Meski tidak semua operator
terlibat, namun MMS sejak saat
itu bisa dikiram-kirim ke dan dari
nomor operator yang berlainan.
Tiga operator (Satelindo,
Excelcom, dan IM3) meneken
kesepakatan MMS lintas operator
ini. Sedang Telkomsel memilih
tidak berpartisipasi dikarenakan
tidak setuju dengan pola revenue
sharing yang ditetapkan.

Ketiga operator tersebut
sepakat untuk menganut asas
sender keeps all selama enam
bulan. Artinya, pendapatan
diperoleh hanya oleh operator
yang menjadi asal pengiriman
MMS. Sedang setelah enam bulan
tersebut, pendapatan akan
dibagi berdasarkan revenue
sharing antara operator pengirim
MMS dengan operator penerima.
Sedang Telkomsel menginginkan
pola sender keeps all ini berlaku
seterusnya dan memilih mangkir
dari kebersamaan ini. Maklum,
Telkomsel merasa mempunyai
pelanggan terbanyak sehingga
yakin akan menjadi asal
pengiriman MMS terbanyak.

MMS sendiri mulai dirintis
sejak April tahun lalu oleh IM3,
diikuti oleh Telkomsel pada bulan
Oktober 2002. Sedang Satelindo
dan Excelcom menyusul dua
bulan yang lalu.

Peluncuran
MMS lintas ope-
rator ini me-
ngambil momen
yang tepat, yaitu
menjelang hari-
hari besar di
mana orang akan
sangat
memerlukan
berkirim ucapan
dan pesan.
Ucapan selamat
hari raya dengan
gaya yang unik
dan multimedia
akan menjadi
pilihan yang
menarik. Ini
seperti fenomena SMS biasa yang
setiap hari raya mengalami
lonjakan yang sangat drastis.

Jika digunakan secara cerdas,
MMS akan sangat efektif untuk
menyampaikan pesan-pesan
tertentu terutama yang
membutuhkan penampilan visual
dan audio. Memang sosialisasi
MMS ini masih lebih banyak me-
nonjolkan unsur fun saja. Namun
sebenarnya banyak aplikasi
dalam berbagai bidang yang bisa
memanfaatkan MMS ini. MMS
bahkan bisa mengangkut data
sebesar 50KB dengan harga yang
hanya 1250 rupiahan. Banding-
kan dengan SMS yang menarik
bayaran sekitar 300 rupiahan
untuk hanya 160 karakter.

Berbagai keunggulan MMS
yang sudah lama terpendam ini
akan muncul dengan
kesepakatan lintas operator
tersebut. Sayang banget harus
ada operator yang tidak
berpartisipasi. PC+

Demo MMS lintas operator: Cakupan MMS makin meluas, pelanggan happy.

CARA MENGAKTIFKAN

Untuk dapat menikmati MMS, pelanggan harus melakukan setting
GPRS dan aktivasi MMS terlebih dahulu. Layanan Over the Air (OTA)
tersedia dengan aturan sebagai berikut:

IM3
Setting M3-GPRS: ketik GPRS<spasi>Merek HP<spasi>tipe HP, dan kirim
via SMS ke nomor 3939.
Setting M3-MMS: ketik MMS<spasi>Merek HP<spasi>tipe HP, dan kirim
via SMS ke nomor 3939.

SATELINDO
Aktivasi MMS: ketik ACT<spasi>MMS, dan kirim via SMS ke nomor 888.
Setting MMS: ketik MMS<spasi>Merek HP<spasi>tipe HP, dan kirim via
SMS ke nomor 3000.

PROXL
Aktifkan GPRS dan MMS dengan menghubungi Layanan Pelanggan di
818 dari kartu proXL atau (021) 57959818 atau ke XL Shop terdekat.
Setting GPRS: ketik GPRS<spasi>Merek HP<spasi>tipe HP, dan kirim via
SMS ke nomor 9667 (hanya untuk Nokia dan Sony Ericsson). Ponsel lain
bis dilakukan secara manual dengan menlihat di situs
www.excelcom.co.id.
Setting MMS: ketik MMS<spasi>Merek HP<spasi>tipe HP, dan kirim via
SMS ke nomor 9667 (hanya untuk Nokia dan Sony Ericsson). Ponsel lain
bisa dilakukan secara manual dengan menlihat di situs
www.excelcom.co.id. PC+
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Untuk memikat hati
pelanggannya (dan

menebar pesona
kepada para calon

pelanggan) para
operator telepon

seluler mempersiapkan
berbagai paket

layanan selama masa
mudik.

ayanan-
layanan ini sangat
berguna karena untuk
membuat peristiwa

mudik kita berjalan lancar
dengan komunikasi dan
informasi yang tersedia
sempurna.

VIDEO
STREAMING

Dengan video streaming
pada ponsel, alat ini bisa
dijadikan layar untuk menonton
hasil bidikan kamera video yang
dipanteng di suatu tempat
tertentu. Hasil shoot kamera ini
kemudian dipancar-kan melalui
streaming server dan bisa diakses
melalui jaringan operator yg
menyediakan akses-nya. Barrier
yang dimanfaatkan adalah
jaringan GPRS.

Operator yang pertama kali
mengintrodusir layanan ini di
tanah air (dan merupakan
operator ke delapan di dunia)
adalah IM3, yang terkenal
dengan layanan-layanan data
dan content-nya yang inovatif.

Saat ini, content yang ada di
menu Video Streaming pada
kartu-kartu IM3 adalah: Live
Streaming dan layanan content
hasil kerja sama dengan SCTV.

Live Streaming berisi
pantauan traffic di 5 kota besar:
Jakarta, Surabaya, Bandung, Bali,
dan Semarang. Pengguna bisa
langsung melihat kondisi di jalan
tersebut, apakah sedang macet
atau sedang ada demo, atau
gangguan lain. Jika Anda mudik
melalui jalan-jalan tersebut, atau
bahkan ketika sudah mudik dan
merayakan Lebaran di daerah
tersebut, maka perjalanan bisa
direncanakan agar tidak terjebak
kemacetan lalu lintas.

Jalanan yang sudah bisa
dipantau adalah: Bundaran
Indosat (Jakarta), Bundaran
Waru, Viaduct Gubeng, Jl.
Panglima Sudirman, Jl. Basuki
Rahmat, dan Jl. Karimun Jawa
(Surabaya), Asia-Afrika
(Bandung), Pantai Kuta (Bali),
dan Simpang Lima (Semarang).

Sedang content yang
disediakan hasil kerjasama
dengan SCTV berupa acara-acara
favorit di SCTV. Saat ini, menu
yang disediakan adalah: Liputan
6 (Breaking News dan Headline
News) dan Infotaiment (Bibir
Plus, Gondangdia, Halo Selebriti,
Hot Shot, Ngobras, Otista, Portal
dan Poster). Laporan berita,
terutama, akan membantu kita
dalam memantau arus mudik
yang biasanya menjadi program
utama stasiun televisi.

Untuk servis ini, IM3
mematok tarif 20 rupiah per KB,

Mudik Asyik
Bersama Operator

F.X. Bambang Irawan
fbi@e-pcplus.com

sama seperti kalau kita
mengakses GPRS biasa.

Telkomsel juga menyusul
menyediakan layanan video
streaming. Sebagai langkah awal,
mereka menyediakan content

yang sangat afdol dalam rangka
bulan suci dan Idul Fitri ini, yaitu
klip video siraman rohani dari Aa’
Gim. Telkomsel mematok harga
3000 rupiah per download (kartu
Halo) dan 3300 rupiah per
download (Simpati).

MOBILE BANKING
Bisa melakukan transaksi

perbankan cukup dengan
memencet tuts ponsel bisa jadi
akan membuat Anda merasa
sangat terbantu sepanjang mudik
Lebaran nanti. Selama setidaknya
seminggu bank akan bertutupan,
ATM pun kebanyakan tak berusia
operasi 24 jam. Jadi ponsel akan
menjadi teller atau ATM
penyelamat Anda.

Beberapa operator ponsel
sudah bekerjasama dengan bank
besar untuk menyelenggarakan
layanan yang suka disebut
dengan m-banking ini. Beberapa
kartu mensyaratkan upgrade ke
memori yang lebih besar agar
dapat diisi dengan SIM Card
Toolkit (STK) yang wajib
hukumnya untuk dicangkoki
dengan menu browser. Browser
inilah yang akan memudahkan
transaksi nasabah karena tinggal
pilih dari menu yang ada di
dalamnya.

Hingga saat ini Telkomsel
telah bekerjasama dengan BNI,
Bank Mandiri, Citibank, Bank
Danamon, Bank Panin, dan Bank
Buana Indonesia. Sedang BCA
menggelar kerja sama dengan
Satelindo dan Excelcom.

Untuk bisa menggunakan

L
ATM, lokasi pom bensin, lokasi
bengkel, hotel, apotik dan rumah
sakit, emergency call, ramalan
cuaca di kota-kota besar serta
jadwal transportasi kereta api,
pesawat, kapal laut serta ramalan
cuaca di kota-kota besar.

LOCATION BASED SERVICE
ProXL mempunyai layanan

untuk menunjukkan lokasi yang
dalam jagad seluler sering
disebut LBS (Location Based
Services). Layanan ini dikemas
dalam paket kartu Life in Hand.
Ada beberapa fitur, yaitu Where
Are U untuk melacak lokasi
teman (yang sama-sama meng-
gunakan ProXL), I Near U untuk
menemukan tempat-tempat
penting seperti ATM dan rumah
sakit terdekat, Safe Trip untuk
keamanan dalam perjalanan.

Untuk memanfaatkan
layanan ini pengguna harus men-
download tambahan menu baru
dari operator melalui menu
browser Life in Hand yang sudah
tersedia.

INFOTOL
Untuk pelanggannya,

Satelindo bekerjasama dengan
Indonesia Media Technologies
(IMT) dan Jasa Marga juga
menyediakan InfoTol yang dapat
diakses melalui menu

Satelindo@ccess. Namun layanan
informasi ini masih terbatas
untuk ruas tol Jagorawi,
Tangerang, Cikampek, Cawang,
dan Pondok Pinang. PC+

InfoTol dapat diakses melalui menu
Satelindo@ccess.

layanan ini, Anda terlebih dahulu
harus melakukan aktivasi ke bank
yang bersangkutan terlebih
dahulu. Jadi, mumpung lebaran
masih lumayan jauh, silakan
daftar m-banking sekarang juga.

ROAMING
Roaming

(nasional) adalah hal
penting yang harus
Anda cermati jika
ingin menggunakan
ponsel sebagai
andalan komunikasi
utama di udik nanti.
Apakah untuk bisa
menerima panggilan
ketika berada di luar
area kartu kita harus
menombok ongkos
roaming?

Telkomsel
menawarkan gratis
roaming untuk
menerima panggilan
di mana pun berada
di seluruh nusantara
selama 15 November
sampai 31 Desember
2003. Tawaran ini
dikemas dalam
layanan Telkomsiaga

2003 yang dikhususkan untuk
mengantisipasi kebutuhan mudik
Lebaran.

IM3 menyusul kemudian
dengan membebaskan ongkos
roaming bagi pelanggannya
dalam menerima panggilan
telepon selama dua bulan, yaitu
sejak 1 November sampai 31
Desember 2003.

Sedang untuk kartu prabayar
Mentari dan ProXL prabayar
sudah lama membebaskan biaya
roaming ini.

PAKET MUDIK
Paket layanan insidental

mudik juga ditawarkan oleh
operator seperti Satelindo
dengan Mentari Paket Mudik.
Paket Mudik merupakan paket
penjualan kartu perdana
MENTARI seharga 50 ribu rupiah
dengan pulsa senilai 25 ribu
rupiah. Jika kartu Mentari ini
diaktifkan pada periode 1
Oktober sampai 31 Desember
2003, pembeli akan
mendapatkan bonus pulsa senilai
Rp 10 ribu.

PROGRAM OFFLINE
Selain menggelar Paket

Mudik, Mentari juga
menyelenggarakan program
Festive Mudik. Festive Mudik
adalah kegiatan untuk
membantu pemudik sepanjang
perjalanan. Pada kegiatan ini
Satelindo mendirikan pos-pos
yang disebut Pos Mudik Asik
Mentari di 50 titik --di sekitar
restoran besar-- sepanjang jalur

mudik Pantura mulai dari
Palembang hingga Denpasar
mulai H-7 sampai dengan H+7.

Pada pos-pos yang
dilengkapi pendingin ruangan
tersebut Satelindo menyediakan
layanan bagi pemudik antara lain
berupa pijat relaksasi, cuci dan
blow rambut, serta minibar yang
menyediakan minuman dan
makanan ringan --semuanya
gratis-- untuk menyegarkan
kembali pemudik setelah melalui
perjalanan panjang menuju
kampung halaman.

Selain itu Pos Mudik Asik
Mentari juga menyediakan
fasilitas Playstation serta TV/VCD
untuk mengisi waktu selama
pemudik beristirahat di pos
tersebut. Bagi pengendara motor
disediakan produk-produk
pelumas gratis. Selain itu
pemudik juga bisa mengikut SMS
Games berhadiah menarik.

Untuk memudahkan
pemudik dalam melakukan
perjalanan, Satelindo telah
memproduksi sekitar 1,5 juta
eksemplar peta mudik yang
dapat diperoleh di kemasan kartu
perdana Mentari maupun
dibagikan langsung. Pada peta
ini tercantum lokasi-lokasi pom
bensin, ATM, rumah sakit,
maupun bengkel terdekat.
Sedang bagi pemudik yang
merasa kurang sehat,
disediakan pos kesehatan
yang menyediakan obat-
obatan bebas untuk
keluhan ringan.

Layanan lain yang
disediakan Satelindo bagi
pemudik adalah
Satelindo Info Center
999. Dengan
menghubungi nomor
999 pengguna
MATRIX dan
MENTARI dapat

memperoleh info-info penting
yang diperlukan selama mudik,
seperti kondisi lalu lintas
Jabotabek dan sepanjang jalur
mudik, lokasi pos Mentari, lokasi
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Mengubah Tampilan
Icon Desktop Linux

(Bagian 2)

P

Willy Sudiarto Raharjo
willy@e-jogja.net

Jika Anda sudah
mendapatkan file

icon desktop seperti
yang dibahas pada

edisi lalu, salah satu
atau keduanya, maka

Anda sudah siap untuk
meng-update icon-icon
Anda. Dari layar desk-

top, pilihlah [K]> [Con-
figuration]> [KDE]>

[LookNFeel]> [Icons].
Anda akan

mendapatkan layar
tampilan seperti pada

Gambar 3.

ada tampilan
tersebut terlihat
bahwa seting default
yang digunakan adalah

Connectiva Crystal – SVG 0.6.

Sekarang kita akan mencoba
menginstal theme baru untuk
icon. Klik pada tombol Install

New Theme dan Anda akan
mendapatkan tampilan seperti
Gambar 4. Layar dialog ini

meminta kita menyebutkan
alamat dan nama file  berisi
daftar icon yang akan kita instal
ke komputer kita. Tentukan
nama file dan alamat tempat
Anda menyimpan. Jika Anda

harus melakukan pencarian, klik
tombol folder di bagian kanan.
Jika sudah ditemukan, pilih file
dan tekan [OK], maka akan
tampak seperti Gambar 5 (Anda

tidak perlu melakukan
penguraian terhadap file yang
mempunyai format tar.gz,

karena proses penguraian akan
dilakukan secara otomatis).

Setelah itu, tekan [OK], dan

proses instalasi icon akan segera di-
mulai. Dalam beberapa detik, pro-
ses instalasi akan selesai dan Anda

akan mendapati icon yang baru su-
dah terinstal dengan baik (Gam-
bar 6). Untuk menginstal paket

theme icon Noia, langkah yang
digunakan sama. Satu hal yang
berbeda, nama paketnya berbeda.

Setelah semuanya selesai,
Anda bisa mencoba
menggunakan icon baru
tersebut, dengan mengarahkan
kursor pada icon yang Anda pilih
dan menekan tombol [Apply].
Dalam beberapa detik, icon yang
baru akan nampak dalam layar
desktop. Proses uninstall juga
sangat mudah. Anda hanya perlu
menekan tombol [Remove
Theme], dan akan keluar dialog
window seperti pada Gambar 7.
Jika Anda berniat untuk
menghapusnya, tekan tombol
[Yes]. Setelah selesai, tekan
tombol [OK] untuk menutup

Gambar 3

Gambar 4

Gambar 5

Gambar 6

window dan kembali ke layar
desktop. Nikmati tampilan
desktop baru Anda.

ICON KHUSUS
Ada satu hal yang perlu kita

ketahui bahwa instalasi icon
hanya akan mengubah icon yang
sudah ada pada paket icon
sebelumnya (dalam hal ini paket
dari KDE,
termasuk aplikasi-
aplikasinya).
Proses ini tidak
akan mengubah
icon-icon dari
paket yang diinstal
melalui source,
misalnya
Sodipodi,
OpenOffice.org.
Meskipun pada
paket-paket
tersebut
disertakan file
icon, namun
secara default, icon tersebut
tidak disalin ke direktori tempat
KDE menyimpan daftar semua

Gambar 7

Gambar 8

icon- nya. Dengan demikian,
Anda tidak akan bisa memilih
icon yang tepat pada saat meng-
update Start Menu Anda
menggunakan MenuDrake
(Gambar 8). Untuk mengatasi
hal itu, maka Anda harus
menyalin icon-icon tersebut ke
direktori /usr/share/icons
(perhatikan bahwa letak direktori
ini mungkin saja berbeda dengan
yang Anda miliki, sehingga Anda
harus melakukan pencarian
ulang).

Pada direktori ini, hampir
semua file mempunyai ekstensi
PNG, sehingga untuk
mempermudah pencarian file
icon, Anda bisa memberikan
perintah locate png (Gambar
9). Terlihat bahwa file icon untuk
paket OpenOffice.org berada

pada direktori /opt/
OpenOffice.org1.1.0/share/
icons. Anda bisa menyalin file
tersebut ke direktori /usr/share/
icons (dengan login sebagai root
tentunya). Setelah selesai, Anda
bisa kembali ke MenuDrake dan
melihat hasilnya (Gambar 10).

Mudah bukan? Sebagai
penutup, jangan takut untuk
mengembangkan kreativitas
dalam mengolah desktop
sehingga kinerja Anda pun
semakin optimal berkat
pengaturan menu-menu dan
tampilan grafis yang menarik.
Pada Gambar 11, Anda bisa
melihat contoh desktop penulis
yang merupakan kombinasi
penggunaan icon Noia dan
Window Decoration Plastic
(yang akan menjadi style standar
untuk KDE 3.2 mendatang).
Semua wallpaper yang ada
maupun paket-paket tersebut
diambil dari situs  "http://
www.kde-look.org/" http://
www.kde-look.org. Untuk
melihat kumpulan koleksi
desktop yang sudah dibuat oleh
penulis dan rekan-rekan penulis,
silahkan berkunjung ke alamat
situs:   "http://
linux.informatix.or.id/screenshot"
http://linux.informatix.or.id/
screenshot.  Akhir kata, selamat
berkreasi. PC+

Gambar 9

Gambar 10

Gambar 11
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Membuat Citra
Komposit (Gabungan)

dengan GNU/GIMP

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

S

Mengolah foto dengan perangkat lunak komersil dan sudah
populer memang mudah dan mengasyikkan. Namun

bagaimana kalau hal tersebut dilakukan dengan perangkat
lunak yang free, opensource, serta terbilang masih baru?

Tentu dituntut kemauan untuk belajar kembali dan
menyesuaikan diri.

eorang yang benar-benar menaruh minat pada
digital imaging justru akan tertantang untuk mencari kesamaan kaidah
operasional antara perangkat lunak yang sudah populer dengan yang baru ini.
Dari sini, akan ditemukan hal-hal yang berlaku universal pada perangkat lunak

pengolah citra.

SELEKSI DENGAN CONTIGUOUS AREA TOOL
1. Buka foto apel. Foto ini memiliki latar belakang yang sederhana, polos dan satu

warna. Subjek yang demikian dapat diseleksi dengan Contigous Area Tool. Klik
ganda, lalu tentukan nilai Threshold. Semakin tinggi nilainya, maka pixel yang
dipilih memiliki kemiripan semakin rendah. Mudahnya, seleksi menjadi semakin luas.

2. Klik kanan di sembarang area foto, pilih [Select]>[Feather]. Beri nilai kecil.
Tujuannya, agar pinggiran seleksi halus, tidak tajam seperti guntingan.

3. Klik kanan lagi, lalu pilih [Select]>[Inverse]. Seleksi akan dibalik sehingga subjek apel
yang menjadi seleksi. Klik kanan lagi, pilih [Edit]>[Copy].

4. Klik menu [File] pada palet Toolbox, lalu pilih
New. Pilih latar belakang Transparent. Buka
halaman kerja baru. Klik palet Layer lewat
menu [File] pada Toolbox> [Dialog]>[Layer,
Path, and Channel]), lalu klik ikon [New layer].
Pilih latar belakang Transparent. Klik kanan di
area gambar, lalu pilih [Select]>[Paste].

5. Sesuaikan ukuran apel dengan
klik [Rotation and Scaling Tool].
Pilih [Scaling], lalu geser handle
point di pojok. Jaga agar skala
panjang dan lebar tetap sama.
Klik tombol Scale.

Contiguous Tool

Slider Threshold

Pilihan
Transparent

Rotate and
Scaling Tool

Pilihan
Scaling

Handle
Point

Skala panjang
dan lebar
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SELEKSI DENGAN BEZIER TOOL
(PATH)
1. Buka foto pisang, lalu buka palet

path. Klik [Bezier Tool] di [Toolbox].
Pilih tombol [New Point] di palet
path. Buatlah path di sepanjang tepi
subjek sampai kedua ujung path
bertemu.

2. Klik tombol [Edit Point], lalu rapikan
path dengan menarik, menutar,
memendekkan handlepoint.

3. Ubah path menjadi seleksi dengan
klik garis path sehingga muncul garis
putus-putus dan berkedip-kedip.

4. Klik kanan di area gambar, pilih
[Select]>[Feather]. Klik kanan lagi,
pilih [Edit]>[Copy].

5. Aktifkan bidang gambar apel. Buka
palet Layer, klik ikon [New Layer],
klik kanan dan pilih [Edit]>[Paste].

6. Sesuaikan ukuran subjek pisang.

LANGKAH TAMBAHAN
1. Percantik citra dengan

menambahkan bayangan. Buka
palet Layer, duplikasi layer apel dan
pisang. Geser sedikit layer tersebut
dengan [Move Tool] di Toolbox.

2. Gelapkan duplikat layer dengan klik
kanan di area gambar, lalu pilih
[Image]>[Color]>[Brightness-
Contrast].

Selamat mencoba. Pertanyaan dan permintaan source file XCF dapat dialamatkan ke e-
mail penulis. PC+

3. Kaburkan bayangan dengan klik ka-
nan area gambar lalu pilih [Filters]>
[Gaussian Blur].

4. Save pekerjaan kita dalam format
XCF (default GIMP, setara dengan
PSD Photoshop yang memuat
informasi layer).

New Point

Handle
Point

Edit Point

Palet layer

New layer

Duplicate layer
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Fungsi-fungsi
Filesystem Di PHP

(Bagian 2)

Yahya Kurniawan
yahya@e-pcplus.com

Dengan beberapa
fungsi filesystem yang
dijelaskan minggu lalu

Anda telah belajar
untuk membuat dan

membaca file teks.
Masih ada beberapa

fungsi lain yang
berhubungan dengan
masalah baca tulis file

ini. Yuk kita bahas
sekarang.

ungsi
rewind()

Fungsi ini
digunakan untuk

mengembalikan pointer ke posisi
awal stream. Sintaksnya adalah
sebagai berikut:

rewind(stream)

Contohnya akan kita bahas
bersama fungsi berikut ini.

Fungsi is_writable()
dan fungsi
is_writeable()

Kedua fungsi ini memiliki sifat
dan kegunaan yang sama yaitu un-
tuk memeriksa apakah kita dapat
menulis ke dalam sebuah file.
Sintaksnya adalah sebagai berikut:

is_writable(namafile)
is_writeable(namafile)

Jika Anda memiliki akses
tulis ke file namafile, maka
fungsi ini akan memberikan nilai
TRUE dan FALSE bila sebaliknya.

Contoh penggunaannya
adalah sebagai berikut:

<HTML>
<HEAD>
<TITLE>Baca Tulis File </TITLE>
<?
$namafile = "/test/
textfile.txt";
$status =
is_writable($namafile);
if (!$status) {

echo "Anda tidak
memiliki ";

echo "hak akses tulis
terhadap ";

echo "file $namafile";
} else {

$file =
fopen($namafile,"w+");

for ($i=1;$i<=10;$i++) {

fputs($file,"Ini baris ke $i\n");
}
rewind($file);
while (!feof($file)) {

$isifile =
fgets($file,128);

echo("$isifile
<BR>");

}
fclose($file);

}
?>
</BODY>
</HTML>

Jika skrip ini Anda jalankan
dan Anda memiliki akses tulis
terhadap file /test/textfile.txt,
maka browser akan memberikan
output seperti Gambar 1. Jika
ternyata Anda tidak memiliki ak-

ses tulis  terhadap file /test/text-
file.txt maka output yang diha-
silkan akan seperti Gambar 2.

Skrip di atas juga memberi-
kan contoh bagaimana menulis
dan membaca file bisa digabung-
kan ke dalam satu skrip saja.
(Pada contoh minggu lalu, skrip
untuk menulis file dan membaca
file dilakukan secara terpisah).

Penjelasannya adalah
sebagai berikut; katakanlah Anda
memiliki hak tulis terhadap file /
test/textfile.txt, maka skrip
akan melompat ke blok setelah
else. Pada blok tersebut sebuah
stream dibuka dan disimpan
dalam variabel $file dengan
mode w+, artinya stream
tersebut nantinya dapat dibaca
dan ditulis (read and write).
Setelah itu skrip akan menulis ke
dalam stream dengan teks “Ini
adalah baris ke n” dengan n
adalah 1 sampai dengan 10. Pada
saat proses penulisan selesai,
pointer sekarang akan terletak di
bagian akhir stream atau dengan
kata lain di belakang angka 10.
Bayangkan jika Anda menulis
dengan pengolah kata seperti
OpenOffice Writer dan menulis
10 baris seperti itu, maka pada
akhir proses, kursor Anda akan
terletak di belakang angka 10.
Bisa dibayangkan bukan?

Jika setelah itu Anda
langsung menggunakan fungsi
fgets() untuk membaca stream
tersebut, Anda tidak akan
mendapatkan hasil apapun,
karena pointer telah berada di
akhir stream. Oleh karena itu
pointer perlu dikembalikan
terlebih dahulu ke awal stream
dengan fungsi rewind(). Itulah
sebabnya mengapa terdapat
fungsi rewind() di tengah-

tengah antara fungsi fputs() dan
fungsi fgets().

Fungsi is_readable()
Fungsi ini merupakan

kebalikan dari fungsi
is_writable(), yaitu memeriksa
apakah Anda memiliki akses baca
terhadap sebuah file. Sintaksnya
adalah sebagai berikut:

is_readable(namafile)

Jika Anda memiliki akses
baca ke file namafile, maka
fungsi ini akan memberikan nilai
TRUE dan FALSE bila sebaliknya.

Bagaimana sekarang apabila
ternyata file yang dibaca
merupakan file HTML?
Katakanlah kita memiliki skrip
sederhana sebagai berikut:

<HTML>
<HEAD>
<TITLE>Test </TITLE>

</HEAD>
<BODY>
Ini teks biasa

<B>Ini cetak tebal </B>
<I>Ini cetak miring </I>
</BODY>
</HTML>

Simpan file ini dengan nama
test.html.

Jika Anda menggunakan
fungsi fgets() biasa (ingat artikel
minggu lalu) untuk membaca file
test.html ini, maka output yang
diberikan browser pun akan
memberikan output sesuai tag
HTMLnya, jadi yang diberi tag
<B> akan dicetak tebal, yang di-
beri tag <I> akan dicetak miring.
Jika Anda menginginkan untuk
mengabaikan tag HTML tersebut,
maka Anda harus menggunakan
fungsi fgetss() (huruf s nya ada
dua). Sintaks dari fungsi fgetss()
adalah sebagai berikut:

fgetss(stream, panjang[,
tag_yang_diijinkan])

Jika parameter
tag_yang_diijinkan tidak diisi,
maka seluruh tag HTML akan di-
abaikan, sehingga yang muncul di
browser hanya teks biasa tanpa
formatting. Bahkan teks yang di-
apit tag <TITLE> pun akan ditam-
pilkan. Contoh penggunaan fungsi
fgetss() adalah sebagai berikut:

<HTML>
<HEAD>
<TITLE>Baca Tulis File </TITLE>
</HEAD>
<BODY>
<?
$namafile = "/test/test.html";
$status =
is_readable($namafile);
if (!$status) {

echo "<FONT
SIZE=5>";

echo "Anda tidak
memiliki ";

echo "hak akses baca
terhadap ";

echo "file $namafile";
echo "</FONT>";

} else {

$file =
fopen($namafile,"r");

while (!feof($file)) {
$isifile =

fgetss($file,128);
echo("$isifile

<BR>");
}
fclose($file);

}
?>
</BODY>
</HTML>

Jika skrip ini dijalankan,
hasilnya akan seperti Gambar 3.
Perhatikan di sana bahwa semua
tag HTML diabaikan, jadi hanya
teks diluar tag HTML yang
ditampilkan.

Sekarang cobalah mengganti
fungsi fgetss() yang ada di skrip
tersebut menjadi sebagai berikut:

$isifile =
fgetss($file,128,”<B>”);

Jalankan skrip tersebut dan
perhatikan apa yang terjadi. Ya,
karena pada parameter
tag_yang_diijinkan diisi dengan
tag <B>, maka tag <B> akan
diijinkan untuk tetap digunakan,
akibatnya teks yang bertuliskan
“Ini cetak tebal” akan benar-
benar dicetak tebal. Jika ada
beberapa tag sekaligus yang
boleh digunakan, penulisannya
adalah sebagai berikut:

$isifile =
fgetss($file,128,”<B><I>”);

Dengan cara ini, maka tag
<B> dan tag <I> diijinkan untuk
digunakan. Jika Anda
menggunakan fasilitas View
Page Source dari output yang
diberikan pada browser, maka
hasilnya adalah sebagai berikut:

<HTML>
<HEAD>
<TITLE>Baca Tulis File </title>
</HEAD>
<BODY>

<br>
<br> Test
<br>
<br>
<br>Ini teks biasa
<br><b> Ini cetak tebal </b>

<br><i> Ini cetak miring </i>
<br>
<br>
<br> <br></body>
</HTML>

Lihat bahwa tag <B> dan <I>
tetap muncul karena memang
diijinkan.

Sampai jumpa minggu
depan. PC+

Gambar 1

Gambar 2



plusInteraksi

| 23

IV • 11 - 17 November 2003
PCplus 152

Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan
mendaftar dengan mengirimkan e-mail  kosong ke mailplus-

subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang

dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat
mengirimkan e-mail pertanyaan ataupun tukar menukar pengalaman

seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika Anda

tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server
DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-
mail berisi beberapa message), kirim e-mail kosong ke mailplus-

digest@yahoogroups.com. Sebagai informasi, setiap hari Jum’at hingga
Minggu adalah hari bebas di milis ini.

Setiap anggota dapat mem-posting e-mail diluar seputar masalah
komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak

software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-mail
OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan
silakan Anda aktifkan kembali ke mode normal dengan mengirim e-mail ke

mailplus-normal@yahoogroups.com.
•Redaksi

Memperkecil
Ukuran Byte

Mailpluser yang baik.
Gimana sih caranya memperkecil
nilai byte (file) dari hasil foto
digital? Apa mungkin ukurannya
bisa jadi di bawah 10 Kbyte?
Gimana ya nih, help me please?

Babe

Jawab:
Biasanya dot per inch

gambar foto dari kamera digital
diatas 200-an karena alasan
untuk dicetak. Untuk konsumsi
layar (misalnya kirim via e-mail
atau untuk background desktop),
set dpi-nya ke 72 sambil ubah
width dan height-nya ke ukuran
layar. Misalnya 800x600. Terakhir,
simpan ke *.jpeg dengan opsi
kompresi antara 30%-40%.
Dengan begitu, sudah cukup

apa namanya dan bisa
didapat di mana?

7. Apa spesifikasi yang harus
dipenuhi untuk bisa
memainkan game PS2 pada
PC?

Fajrin Akbar

Jawab:
1. Tidak bisa. Makanya Anda

diminta untuk meng-install
dulu DirectX 9-nya. Biasanya
sudah disertakan di dalam
CD game yang
membutuhkan DirectX 9
tersebut.

2. Kalau ini bisa, karena
DirectX-nya lebih tinggi dari
yang dibutuhkan

3. Kalau Anda masih sering
bermain game DirectX 8,
GeForce-4 Ti4200 masih
enak, tetapi kalau ke
depannya Anda juga ingin
main game DirectX 9 (dan
game DirectX 8 juga), ambil
Radeon 9500Pro. Kalau soal
harga, masih enakan Radeon

drastis tuh ukuran byte-nya
berubah tanpa banyak
mengurangi kualitas foto.

Sebagai contoh, Anda bisa
coba melakukannya dengan
Ulead Photo Explorer 7.0 Pro.
Setelah di browse, sorot file
gambar yang mau diubah.
Setelah itu klik kanan cari convert
image files. Di sana ada beberapa
pilihan di antaranya adalah:
1. Convert file format to: ......
2. Convert data type size to: .......
3. Resample image size to: ........

Gitu aja. Tapi yang paling
gampang ya ngecilin resolusi
tadi. Kalau standarnya 2000-an x
2000-an (bahkan lebih) jadi cuma
1800 x 1600 atau cukup 1024 x
768. Makin kecil resolusi, makin
kecil ukuran file.

Oyi Kresnamurti, Aries Rohiyanto,
Adhitya F. Anggoro

kamera digital tersebut juga
menyediakan kabel USB untuk
koneksi ke komputer.

Install saja driver dan pro-
gram yang disediakan oleh ka-
mera digital. Biasanya begitu
kabel USB ditancepin ke kompu-
ter, kamera digital akan ter-
detect secara otomatis. Apalagi
kalau Anda menggunakan sistem
operasi Windows XP.

Foto yang disimpan di
memori kamera digital juga tentu
bisa ditransfer ke komputer. Bisa
pakai software bawaan kamera
atau pakai program lain seperti
ACDSee dan sejenisnya. Bahkan
ada juga yang bisa dibuka
langsung lewat Windows
Explorer.

Cara lainnya adalah dengan
menggunakan card reader.
Nanti tinggal pasang card
reader-nya ke komputer dan
kalo mau pindahin data tinggal
masukin memory card kamera
Anda ke card reader. Biasanya
setelah dimasukkan, di Win-
dows Explorer juga akan keluar
icon seperti drive baru. Setelah
itu tinggal copy saja.

Buat nge-print-nya, Anda
tentu butuh printer berwarna.
Di software fotonya pasti ada
opsi buat nge-print foto. Kalo
mau gampang, pake aja
bawaan Office, Photo Editor,
atau Photoshop.

Adhitya F. Anggoro, Babe, Adri
Febrianto

9500 dibanding Radeon
9600. Hanya masalah
ketersediaan saja yang
membuat Radeon 9500
sudah sulit ditemukan.
Kalaupun Anda beli GeForce
FX5600 dan Radeon
9600Pro, ya masih oke
banget kok. Nggak usah
khawatir betul-betul buruk.

4. Pada DirectX 8, Ti4200
memang lebih baik daripada
FX5600. Tetapi di DirectX 9,
FX5600 lebih baik dari
Ti4200. Setahu saya, kinerja
Radeon 9600Pro masih kalah
tipis dibanding dengan
Radeon 9500Pro.

5. Tidak ada masalah.
6. Yang gue tahu cuma ada di

www.pcsx2.net
7. Nggak tahu persisnya. Yang

pasti DVD-ROM dan
kayaknya spek-spek PC
sekarang mestinya sudah
mampu kok.

Adri Febrianto

DirectX
dan Kartu Grafis

Hallo teman-teman milis,
saya punya masalah nich, tolong
saya ya.
1. Bisakah game 3D berbasis

DirectX 9.0 dimainkan di
komputer yang memiliki
(ter-install) sistem DirectX
8.1?

2. Sebaliknya, bisakah game 3D
berbasis DirectX 8.1
dimainkan di komputer yang
memiliki (ter-install) sistem
DirectX 9.0?

3. Mana di antara chipset kartu
grafis berikut yang paling
baik untuk aplikasi game 3D
terkini: GeForce-4 Ti-4200-8x,
GeForce FX5600, Radeon
9600Pro atau Radeon
9500Pro?

4. Sebagaimana yang pernah
dibahas di PCplus nomor 125
yang  berjudul "Apakah
kartu grafis baru selalu lebih
cepat", apakah betul
GeForce-4 Ti-4200 lebih baik
dari  GeForce FX5600, dan
apakah betul Radeon
9500Pro lebih baik daripada
Radeon  9600Pro? Yang saya
risaukan, apabila saya
membeli kartu grafis ber-
chip GeForce FX5600 atau
Radeon 9600Pro, hasilnya
malah betul-betul buruk.

5. Bisakah kartu grafis DX 9.0,
misalnya GeForce
FX5800Ultra di-intall-kan
sistem  Direct X 8.1, dengan
alasan game saat ini rata-
rata masih menggunakan
DX 8.1?

6. Adakah software agar bisa
memainkan game PS2 di PC,

Mencetak
Foto Digital

Hai teman-teman milis,
tolong saya dong. Saya ingin
tanya, kalau hasil foto digital
ingin ditampilkan ke komputer
untuk kemudian dicetak ke
printer bagaimana caranya ya?
Maklum masih gaptek nih.

Wundi

Jawab:
Kalo punya kamera digital,

pasti Anda punya juga CD-nya
yang berisi driver dan aplikasi
yang bisa menampilkan foto di
dalam kamera berikut menu ke
printer. Biasanya pada kemasan

A
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ARE/PCplus

Membuat Wallpaper

Hello guys, gue minta bantuannya nich. Ada yang tau gak
software untuk mengubah gambar hasil scanning jadi wallpaper
dengan tetap mempertahankan output-nya? Minimal setting 800 x
600 atau 1024 x 768. Thanks.

As Sekop

Jawab:
Anda bisa mencoba pakai ACDSee 5. Caranya mudah. Tinggal

klik kanan pada gambar, langsung muncul menu opsi untuk
membuat jadi wallpaper (Pilihannya ada centered, tiled, ataupun
kembali ke wallpaper asal)  dan kayanya gak ngerubah setting
pixel-nya deh.

Cara lain tentunya saat Anda melakukan scanning, pilih scan
minimal pake 150dpi kalo mau bagus coba di 300dpi (kalau gambar
kecil pakai DPI yang gede). Kalau sudah jadi, tinggal buat gambar
itu jadi wallpaper lewat Display Properties.

Edwin, hoeda, Wistiaman

✔

+

✔

+

✔

+

✔

+
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NF7-S:
nForce-2 yang Didandani
Fitur Khas Abit

Spectrum Computindo
www.abit.com.tw
☎ (021) 6125503

111 dolar AS

Chipset nVidia
nForce-2 400 memang
bukanlah chipset terbaru untuk
AMD K7. Namun produk
motherboard yang
memanfaatkan chipset tersebut
sebagai pengontrol utama
perangkat-perangkat pada PC
masih banyak kita jumpai di
pasaran.

Salah satu produk yang
menggunakan chipset nForce-2
400 pada board-nya adalah
Abit seri NF7-S. Seperti juga seri
lainnya, produk yang
menggunakan chipset ini
tersedia dalam beberapa versi
lain yaitu NF7 dan NF7-M. Pada
seri NF7 tidak tersedia fasilitas
FireWire dan Serial ATA.
Sedangkan pada NF7-M
meskipun juga tidak
menyediakan dua fitur tadi,
tetapi tersedia fasilitas grafis
sekelas GeForce-4 MX
terintegrasi pada northbridge-
nya.

Produk Abit NF7-S ini
sebenarnya merupakan salah
satu produk nForce-2 pertama
yang datang di lab PCplus,

namun karena satu dan lain hal,
produk ini harus ditukar
beberapa kali sebelum dapat
kami uji dengan lancar.

Dari sisi fitur, motherboard
yang menggunakan form factor
ATX berukuran 24,4 x 30,4 ini
cukup lengkap. Dengan
menyediakan Serial ATA150 RAID
controller, 6 channel audio dari
nVidia SoundStorm lengkap
dengan keluaran S/PDIF, FireWire,
dan LAN terintegrasi, produk
keluaran Abit yang satu ini
pantas dijadikan incaran bagi
Anda yang akan membangun
platform PC berbasis AMD yang
optimal.

Selain fitur tersebut, produk
ini dilengkapi pula dengan fitur
teknologi khusus motherboard
Abit yaitu Abit SoftMenu yang
dapat memudahkan
penggunanya untuk
mengustomasi kecepatan dan
tegangan prosesor, memori, serta
kartu grafis. Fitur berikutnya
yaitu MaxFID dapat digunakan
untuk memilih beberapa setting
untuk meng-overclock prosesor.
Untuk melindungi dari panas

yang berlebih, ada fitur CPU
ThermalGuard. Sedangkan satu
fitur lagi yang tersedia adalah
Serillel. Fitur ini merupakan
kemampuan untuk
memasangkan harddisk parallel
ATA ke port Serial ATA di
motherboard lewat sebuah
konverter.

Untuk kelengkapan bawaan,
Abit menyertakan sebuah kabel
IDE ATA66/100/133, sebuah kabel
floppy, CD berisi driver dan utility
software tambahan, sebuah
bracket USB 2.0, bracket FireWire,
I/O shield, kabel Serial ATA,
converter Serillel, buku manual,
dan manual untuk Serillel.

Soal kinerjanya,
motherboard yang menyediakan
sebuah slot AGP 4x/8x ini cukup
baik. Meskipun pada kondisi
standar clock motherboard Abit
ini lebih tinggi dari seharusnya,
pada pengujian yang kami
lakukan kali ini tidak ada
permasalahan apapun yang
timbul. Sebagai informasi,
prosesor Athlon XP 3000+ yang
seharusnya berjalan pada
kecepatan 2166,67MHz, pada

motherboard ini sedikit
dikerjapaksakan pada kecepatan
2171,52MHz. Kecepatan tersebut
merupakan hasil kali 13 (multi-
plier) dengan 167,04MHz yang
merupakan clock system (default
166,67MHz).

Seperti biasa, Abit NF7-S ini
kami uji dengan menggunakan
prosesor standar untuk pengujian
motherboard AMD yaitu
AthlonXP 3000+. Untuk
memorinya, kami menggunakan
dua keping memori Corsair DDR
PC-3200 masing-masing
berkapasitas 256MB. Untuk
kartu grafisnya, kami
memasangkan Gigabyte GV-
R96P128D yang merupakan kartu
grafis chip ATi Radeon 9600Pro
128MB, sedangkan untuk data,
kami menggunakan Seagate
Barracuda ATA IV 7200rpm 40GB.
Sistem operasi yang kami
gunakan adalah Windows XP
Professional. (fmn)

SysMark 2002
Rating :266
Internet Content :335
Office Productivity:212

SisoftSandra 2002
ALU :8175 MIPS
FPU :3252 MFLOPS

3D Mark 2001
640 x 480  16bit :14471
640 x 480  32bit :14165
800 x 600  16bit :13055
800 x 600  32bit :12606
1024 x 768  16bit :11294
1024 x 768  32bit :10990

Quake III Arena
640 x 480  16bit :299,6fps
640 x 480  32bit :300,2fps
800 x 600  16bit :294,5fps
800 x 600  32bit :291,8fps
1024 x 768  16bit :267,2fps
1024 x 768  32bit :251,2fps

ALEX/PCplus
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PCPartner RS300MS4-A26:
Mobo Berbasis ATI dengan
VGA Onboard Radeon 9100

Prima Data Abadi Karya
www.pcpartner.com.hk

☎ (021) 6121340

ATI yang selama
ini dikenal sebagai produsen
chipset kartu grafis kini
memang membuat juga chipset
untuk motherboard. Meski
belum banyak tipe yang
memanfaatkan chipset-nya, toh
kehadirannya tidak bisa
dianggap enteng. Salah satu
produsen yang mengeluarkan
seri motherboard berbasis
chipset ATI adalah PCpartner
yang mengeluarkan tipe
RS300MS4-A26.

Kesan pertama yang
muncul adalah kesederhanaan
fitur yang diusungnya. Yang
menarik dari produk yang
berbasis Pentium-4 dengan
dukungan technologi hyper-
threading ini adalah fitur kartu
grafis onboard. Dengan
dukungan kartu grafis onboard
dari kelas Radeon 9100 IGP,
PCPartner mencoba untuk
memuaskan pengguna
produknya dengan fitur kartu
grafis onboard yang cukup
memadai. Fitur ini juga
ditunjang pula dengan
kemampuan untuk melakukan
share memori utama hingga

128MB. Meski memiliki fitur VGA
onboard, produk dengan resolusi
maksimal 2048x1536 untuk VGA
onboard ini tetap menyediakan
port AGP hingga mode 8X
sebagai opsi bila pengguna ingin
meningkatkan kemampuan
grafisnya dengan kartu
tambahan yang kelasnya lebih
tinggi.

Motherboard dengan warna
dasar kuning keemasan dengan
form factor mini ATX ini datang
dengan menggunakan chipset
RS300 untuk chipset north bridge
dan SB200 untuk south
bridge-nya. Khusus untuk
urusan memori, produk
ini memang masih setia
pada sistem lama dengan
single channel. Dua buah
soket DIMM 184 pin yang
disertakan mampu
menampung DDR PC-3200
hingga 2GB.

Selain itu, produk yang juga
dilengkapi dengan controller
suara onboard ALC650 AC’97 ini
juga dipersenjatai dengan 3 buah
port PCI untuk menampung kartu
tambahan berbasis interface ini.
Untuk urusan perangkat input-

output, sistem yang dilengkapi
heatsink sebagai pendingin
chipset north bridge-nya ini juga
dilengkapi dengan USB versi 2.0
yang bisa diekspansi hingga 6
buah.  Fitur mutakhir lain semisal
serial ATA, firewire, dan control-
ler LAN onboard tidak disertakan
pada produk yang juga
dilengkapi dengan power
management ini.

Dari BIOS yang disertakan,

PCPartner nampaknya juga ingin
mencoba mengakomodasi para
overclocker dengan fitur-fitur
yang cukup menarik. Selain
memiliki fitur untuk overclock
FSB per 1MHz, untuk fitur untuk
mengutak-atik memorinya juga
cukup banyak.

PCplus menguji dengan
menggunakan Pentium-4 3GHz
FSB 800MHz, harddisk Barracuda
ATA 7200.7 40GB, dan power
supply Enlight 420watt, Monitor
Samsung SyncMaster 990NF .
Untuk memorinya, PCplus
menggunakan memori ber-chip
Samsung dengan CAS Latency 3
sebesar 512MB. Pengujian
dilakukan dengan menggunakan
pernati lunak benchmark standar.

Dari uji yang
dilakukan, sulit

untuk memban-
dingkannya

dengan yang
lain

SysMark 2002
Rating :305
Internet Content :422
Office Productivity:221

3D Mark 2001
640 x 480  16bit :7310
640 x 480  32bit :7098
800 x 600  16bit :6723
800 x 600  32bit :6541
1024 x 768  16bit :5800
1024 x 768  32bit :5399

Quake III Arena
640 x 480  16bit :171,4fps
640 x 480  32bit :164,3fps
800 x 600  16bit :125,8fps
800 x 600  32bit :119,8fps
1024 x 768  16bit :81,6fps
1024 x 768  32bit :78,1fps

berhubung memori yang
digunakan bukan memori yang
biasa dipakai lantaran masalah
kompatibilitas. Namun, dilihat
dari skor yang didapat dengan
menggunakan VGA onboard,
terlihat performa yang didapat
sangat menjanjikan, meski
dengan menggunakan memori
berkapasitas setengah dari
biasanya.

Buat pengguna yang
menginginkan sistem yang
punya fitur standar dengan
harga terjangkau dan memiliki
VGA onboard yang memadai,
produk ini memang bisa jadi pi-
lihan yang cukup menarik. (sil)

ARE/PCplus
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Asus P4P800S:

Mobo Single Channel
Berchipset Intel

Astrindo Senayasa
www.asus.com.tw
☎ (021) 6121330

111 dolar AS

Bagi perusahaan yang ingin produknya diulas pada rubrik ini, silakan kirim produk tersebut ke alamat Redaksi. Produk yang dikirimkan sebaiknya merupakan paket penjualan,
sesuai dengan yang akan dipasarkan. Sertakan pula informasi detail mengenai produk, nama distributor, telepon yang dapat dihubungi, dan kisaran harga produk tersebut untuk

end-user. Kami tidak memungut biaya apapun untuk produk yang dimuat, sedangkan pengujian dilakukan berdasarkan produk yang kami terima terlebih dahulu.

WinFast TV2000 XP Expert:

Bukan Cuma
Nonton TV di PC

Diamonindo
www.winfast.com.tw

☎ (021) 6122156

SysMark 2002
Rating :321
Internet Content :436
Office Productivity:237

3D Mark 2001
640 x 480  16bit :16360
640 x 480  32bit :15933
800 x 600  16bit :15037
800 x 600  32bit :14667
1024 x 768  16bit :13431
1024 x 768  32bit :12745

Quake III Arena
640 x 480  16bit :361,5fps
640 x 480  32bit :364,7fps
800 x 600  16bit :350,4fps
800 x 600  32bit :345,3fps
1024 x 768  16bit :306,5fps
1024 x 768  32bit :285,9fps

Salah satu produk
terbaru dengan dukungan
chipset terbaru dari Intel
diluncurkan oleh Asus. Produk
yang satu ini diberi nama
P4P800S yang mengusung
chipset i848P yang diprediksi
akan menggantikan chipset
sebelumnya yaitu i865P.

Berbeda dari chipset yang
akan digantikannya, produk
dengan warna kuning keemasan
ini hanya didukung oleh
teknologi single channel untuk
memori utamanya. Namun
begitu, dukungan terhadap
memori double data rate pada
dua soket DIMM yang
dimilikinya tetap mempu
menjalankan DDR-PC-3200 pada
kecepatan standarnya hingga
kapasitas 2GB. Sementara Untuk
urusan prosesornya,  produk ini
mampu menampung prosesor
Pentium-4 478 pin dengan FSB
800MHz.Untuk menampung

TV tuner semacam
ini memang bukan barang
baru lagi. Perangkat multime-
dia yang satu ini memang
cukup banyak diproduksi oleh
beberapa produsen. Salah
satunya adalah Winfast yang
mengeluarkan beberapa tipe
dengan fitur yang beragam.
Salah satunya adalah TV2000
XP Expert.

Datang menggunakan
warna dasar hijau, produk yang
menggunakan produk buatan
Taiwan ini tidak hanya dapat
berfungsi sebagai TV tuner tapi
juga sebagai FM tuner maupun
sebagai capture card. Dengan
menggunakan chipset
CX2388X, produk yang
menggunakan interface PCI ini
menggunakan teknologi video
decoder sebesar 10 bit. Dengan
teknologi video decoder 10 bit
ini, kualitas gambar yang
dihasilkan jelas lebih baik
ketimbang produk lain yang
masih menggunakan teknologi
8 bit.

TV2000 XP Expert ini mampu
bekerja pada standar video
NTSC, PAL, dan SECAM sehingga
kompatibel digunakan di mana
saja. Sementara, untuk urusan
audionya, produk yang
mendukung 3 input yaitu S-video,
TV/FM, maupun composite ini
dilengkapi dengan kemampuan
stereo sehingga suara yang
dihasilkan cukup enak untuk
didengar, baik ketika digunakan
untuk menonton TV, radio, atau
aplikasi multimedia lainnya.
Untuk suara, disertakan pula
sebuah port audio-out yang
nantinya terhubung dengan
konektor audio-in pada
motherboard atau pada kartu
suara.

Fitur-fitur yang ditawarkan
oleh Winfast boleh dibilang
cukup lengkap. Fitur Picture in
Picture (PIP) misalnya
memungkinkan pengguna tetap
menyaksikan tayangan TV
sementara layar yang lain
menampilkan frame yang sedang
di-capture. Fasilitas lain lagi yang

cukup menarik adalah
Time-Shifting yang
memungkinkan
tayangan televisi diputar
sesuai kemauan, misalnya
melakukan pengulangan
atau penghentian
sementara sehingga
pengguna tidak kehilangan
adegan-adegan seru di TV. Fitur
untuk TV yang paling menarik
adalah  kemampuan untuk
menyalakan TV sesuai jadwal
yang ditentukan sendiri oleh
pengguna. Selain waktu, saluran
yang ingin ditonton juga bisa
diatur dengan menggunakan
fasilitas yang tersedia pada
software-nya.

Dengan menggunakan
software yang ada, tayangan di
TV pun dapat direkam baik
sebagai snapshot maupun
sebagai video baik dalam format
MPEG1/MPEG2, MPEG4, DVD, dan
lain-lain.

Selain TV, produk yang
dilengkapi  dengan antena radio
ini juga mampu menangkap

gelombang radio FM pada range
frekuensi yang cukup lebar.
Menariknya, dengan adanya port
AV-in, tuner ini juga bisa
disambungkan dengan camcoder,
VCR, DVD/VCD player, atau
bahkan kamera dan webcam.
Adanya kemampuan tambahan
ini jelas menguntungkan buat
pengguna yang tak ingin
sistemnya dipenuhi beragam
kartu multimedia tambahan
lainnya.

Dari sisi software yang
digunakan, interface yang
ditampilkan terkesan memang
cukup sederhana. Tidak banyak
fitur yang ditampilkan pada
tampilan utamanya. Meski
begitu, setting  yang tersedia
tetap tergolong cukup lengkap

yang didapati pada tiap bagian.
Software utamanya juga
memungkinkan adanya fasilitas
teletext saat menjalankan
aplikasi TV.  Selain software
utamanya, Winfast juga
melengkapi produk ini dengan
software grafis, video editing,
DVD, dan game 3D.

Pada kemasan jualnya,
Winfast juga menyertakan buku
instalasi dan buku keterangan
fitur-fitur yang ada, sebuah
remote control beserta kabel
dengan sensor infra-red, dua
baterai jenis AA, kabel audio,
antena FM, dan CD driver. (sil)

ARE/PCplus

kartu grafis, sebuah port AGP
universal 8X/4X diletakkan di
bagian tengah yang dilengkapi
dengan penguncinya. Adanya
pengunci ini memang cukup
bermanfaat, agar kedudukan
kartu grafis bisa lebih mantap.

Yang menarik, dengan
mengusung chipset south bridge
ICH5, fitur-fitur yang dibawa
produk ini tidak jauh berbeda
dengan fitur-fitur yang dibawa
produk kelas performance. Lima
buah port PCI disertakan untuk
menampung kartu-kartu tam-
bahan yang mungkin dipasang.
Port ini juga ditambah dengan
sebuah port Wi-Fi Asus yang
memungkinkan sistem terkoneksi
ke dalam jaringan secara nirkabel.

Seperti juga pada
motherboard mutakhir, P4P800S
yang menyertakan heatsink hitam
sebagai pendingin chipset north
bridge-nya ini juga menyertakan
dua buah slot Serial ATA untuk
harddisk berteknologi terbaru.

Namun begitu, Asus juga tetap
menyertakan dua buah port IDE
untuk harddisk standar, plus
sebuah port untuk floppy.

Untuk interface maupun
input-output yang tersedia,
motherboard ini juga tetap
menghadirkan fitur modern
semisal USB 2.0, firewire hingga
maksimal 8 port, dan lain-lain.
Audio controller yang disertakan
yaitu AD1888 juga memungkin-
kan pengguna menggunakan
speaker 5.1 tanpa perlu kartu
suara tambahan apapun. Selain
itu, disertakan pula interface S/
PDIF out untuk pengolahan suara
yang lebih baik. Tak lupa,
dilengkapi pula Realtek RTL8100C
10/100Mbps untuk LAN onboard
yang port-nya menyatu dengan
port USB pada bodi motherboard.

Fitur-fitur pada BIOS juga
cukup progresif untuk ukuran
motherboard berharga
terjangkau. Selain dilengkapi fitur
CrashFree BIOS2 dan EZ Flash,
beberapa fitur di dalamnya cukup
lumayan buat digunakan untuk
overclock. Fitur Stepless Frequency

Selection misalnya memberikan
kemampuan untuk meningkatkan
FSB setiap 1MHz. Fitur lainnya
adalah Performance Mode yang
bisa diatur pada kecepatan turbo
sehingga meningkatkan performa
cukup signifikan. Ketika diuji, pro-
duk ini memang boleh dibilang
sangat stabil pada Performance
Mode: Auto. Namun, ketika diuji
dengan menggunakan 3Dmark
2001 dengan setting Performance
Mode: Standard, kestabilan
sistem terlihat menurun.

PCplus juga menguji produk
ini dengan menggunakan test bed
standar PCplus seperti Pentium-4
3GHz FSB800MHz, memori
Kingston PC-3200 512MB CL2 dua
keeping, harddisk Barracuda
7200.2 40GB, kartu grafis MSI
GeForce 4 Ti 4800 128MB, power
supply Enlight 420W. Seperti
biasa, PCplus menggunakan driver
Intel INF 502.1003 dan driver
nVidia 44.03.

Dari hasil yang diperoleh,
tampak hasil yang dicapai cukup
memuaskan. Meski menggunakan
single channel, skor yang didapat

tidaklah jauh berbeda dibanding
produk lain yang menggunakan
dual channel. Alhasil, bila
dibandingkan dengan harganya,
performa yang didapat memang
cukup menggiurkan. (sil)
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Pilih Barang
yang Punya

Pelayanan Terbaik
T.J. Setyoadi
dino@e-pcplus.com

K

Apa yang harus jadi
pertimbangan utama

dalam memilih
komputer? Jawabnya
adalah pelayanannya,

baru kemudian
keunggulan

teknisnya. Lho, kalau
barangnya jelek tapi
pelayanannya bagus

bagaimana? Tetap
saja, karena secara
alamiah kita selalu

memilih yang
pelayanannya terbaik

dan sesuai dengan
kebutuhan kita,

walaupun kualitasnya
mungkin bukan yang
paling bagus. Nggak
percaya? Simak saja
artikel di bawah ini.

enapa selalu
ASUS? itulah
sebuah pertanyaan
dari seorang

penggemar workshop yang
diadakan oleh PCplus Surabaya.
Pertanyaan ini memang
menggelitik kesadaran saya.
Apa iya PCplus punya perjanjian
khusus dengan ASUS?

 “Perjanjian khusus
memang tidak ada, tapi kenapa
hanya ASUS saja, apa tidak ada
yang lain?” kejar penggemar
workshop tersebut. Saya sendiri
agak bingung juga
menjawabnya, karena memang
baru saya sadari bahwa
memang dari sekian banyak
workshop yang diadakan PCplus
di Surabaya, hanya satu saja
yang tidak disponsori oleh
ASUS.

Kemudian satu hal lagi juga
saya sadari, bahwa ASUS-lah
yang selalu dengan cepat
merespon permintaan PCplus
untuk menjadi sponsor work-
shop. Pelayanannya juga cepat,
apa-apa yang dibutuhkan oleh
PCplus disediakan dengan baik
oleh ASUS. Akhirnya dengan
sendirinya dalam benak saya
muncul persepsi bahwa ASUS-
lah yang terbaik.

Apakah merek lain seperti
Gigabyte, MSI, Intel, IWill, atau
yang lain tidak bisa seperti
ASUS? Bisa, tapi apakah mereka
mau bergerak secepat ASUS?
Pasti mau, tapi pada
kenyataannya sampai saat ini
ASUS-lah yang selalu dengan
sigap untuk memberikan yang
terbaik.

Benarkah produk ASUS
yang terbaik? Jika

dibandingkan secara teknis
dengan merek motherboard lain,
mungkin tidak terlalu jauh
berbeda. Saat ini di kalangan
mahasiswa di Surabaya
motherboard Gigabyte dianggap
lebih baik dari merek
motherboard manapun. Hal yang
sangat wajar mengingat
Gigabyte pada beberapa bulan
yang lalu memang mengadakan
roadshow di sepuluh kampus di
Surabaya. Tapi kenyataannya
kebanyakan toko komputer di
Surabaya masih
merekomendasikan ASUS. Hal ini
terjadi karena outlet ASUS sudah
ada di mana-mana, dan
pelayanannya dalam masalah
servis memudahkan pedagang
komputer. Jadi hal inilah yang
harus dilakukan oleh Gigabyte,
MSI, Intel, ataupun merek
motherboard lain kalau ingin
mengalahkan ASUS. Bukan
keunggulan produknya.

Apa merek memori yang
terbaik di Surabaya? Untuk saat
ini adalah Visipro, karena hampir
semua toko komputer di
Surabaya merekomendasikan
penggunaan Visipro (entah
dengan kota yang lain). Lalu
kenapa dengan memori
Kingston, OCZ, Corsair, Spectek,
atau merek lain yang dibuat dan
menguasai pasar di Amerika
kalah dibandingkan dengan
Visipro? Anda tahu Visipro dibuat
di mana? Amerika? Thailand?
Philipina? Taiwan? Korea?
Bekasi?

Kebanyakan pengguna dan
penjual komputer juga tidak tahu
dan tidak berusaha mencari tahu
Visipro dibuat di mana, tapi
kenapa Visipro menguasai
pangsa pasar? Karena
pelayanannya bagus. Dialah
produk yang memberi jaminan
seumur hidup pertama kalinya di
dunia bisnis komputer di Indone-
sia. Jadi, kalau memori Anda
bermerek Visipro dan sedang
rusak, bawa saja ke dealer-nya,
langsung diganti tanpa ada
pertanyaan macam-macam.
Betulkah kualitas Visipro adalah
yang terbaik? Belum tentu, tapi
mana ada merek memori selain
Visipro yang memberikan garansi
seumur hidup? Mungkin ada, tapi
Visiprolah yang pertama kali
melakukannya dan garansi
seumur hidup oleh masyarakat
dianggap sebagai layanan Visipro
saja, yang lain hanya meniru.

Apa merek harddisk yang
terbaik di Surabaya? Seagate?
Maxtor? Quantum? IBM? Tidak
ada pemimpin pasar, karena kita
menganggap bahwa semua
merek tersebut sama, baik dalam
kualitas barang maupun

pelayanannya. Tapi dua merek
unggulan adalah Seagate dan
Maxtor. Namun tampaknya
Seagate sedang tancap gas,
dengan mensponsori berbagai
kegiatan dan sosialisasi produk
terbarunya yang menggunakan
interface SATA, interface untuk
harddisk yang paling gres dan
diakui punya keunggulan dalam
kecepatan dan maupun
kekuatan. Bisakah Seagate bisa
jadi pemimpin pasar? Kita lihat
saja.

Baru-baru ini Samsung
meluncurkan jajaran laser
printer-nya yang terbaru.
Printer Samsung ini lebih kecil,
hemat listrik, hemat toner, dan
sudah menguasai pangsa pasar
di 8 negara maju seperti
Spanyol dan Inggris.
Pemasarannya pun juga cukup
gencar, dan intensif. Tapi
apakah Samsung dengan segala
kelebihannya langsung mampu
mengungguli HP, pemimpin
pasar laser printer saat ini?
Tidak.

Banyak yang percaya
bahwa laser printer Samsung
memang lebih baik dari HP, tapi
kenapa masyarakat masih tetap
memilih HP? Karena toner HP
masih lebih mudah dibeli di
mana-mana. Kalau habis di toko
ini, pasti ada di toko itu. Sesial-
sialnya pasti ada saja toko yang
menjual toner HP. Percayakah
masyarakat bahwa toner
Samsung ada di mana-mana
seperti HP? Belum.

Ada tiga pemain besar
dalam bisnis printer inkjet, yaitu
HP, Epson, dan Canon. HP diakui
mampu menghasilkan warna
yang paling cerah dan cocok
untuk presentasi, Epson dikenal
mampu menghasilkan warna
yang sangat natural dan
bahkan bisa menyamai foto.
Canon….? Dua hal yang
terpenting dalam menghasilkan
cetakan berwarna sudah
diambil HP dan Epson, tapi
kenapa penjualan Canon lebih
banyak dibandingkan HP dan
Epson? Karena tinta Canon
mudah disuntik. Terpikirkah
oleh Canon bahwa dia bisa
menguasai pangsa pasar karena
tintanya mudah disuntik? Tidak.

Jadi kalau membeli
komputer yang harus Anda
perhatikan adalah
pelayanannya. Jika suatu saat
komputer Anda ngadat, Anda
tahu siapa yang harus dimintai
bantuan. Itu yang terpenting.
Apa gunanya membeli barang
yang punya kualitas terbaik
tapi tidak bisa membantu Anda
jika Anda sedang
membutuhkan? PC+
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 210
Asus P4P800 Deluxe, i865,
FSB 800, ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 137
Asus P4C800, i875, FSB800,
4DDR, RAID, Audio, Gigabit LAN 189
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 74
Asus P4S8X/L 1394, SiS648,
FSB533, 3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89
Asus P4P800S, i848P, FSB800,
2DDR, audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 115
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107

Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 100
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 115

APLUS AP984, i865PE,
FSB 800MHz, 4DDR400, ATX, AC97 93
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 70
APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 54
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100,
AGP8X, 6PCI 200
MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 3PCI 65
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 71
MSI 648 MAX-V, SiS 648x,
ATX, FSB533, 3DIMM, ATA133,
AGP8X, 6PCI 68
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 160
MSI 655 MAX LS, SiS655, ATX, FSB533,
4DIMM, ATA133, SATA, AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX, FSB800,
2GBDDR, ATA133, AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49
Matsonic 9127C, VIAP4X400,
FSB533, USB2.0, DDR400, AGP8X 55

Matsonic 9327D+, SIS650,
FSB533, USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX, FSB800,
3DDR400, AGP8X, HTT 69
Matsonic 9367E, SIS 650GX, FSB533,
2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A, FSB266,
2DDR, VGA ONBOARD +AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD + AGP 58
Matsonic 8167C, VIA KT333, FSB266,
3DDR333, AGP 4X, AUDIO 51
Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 79
Gigabyte GA-7N400-EL, nForce2 ultra,
ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133, AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M,
VIAK8T800, FSB800, 3DDR,
SATA, AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 195
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155

DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 90
DFI 648FX-ALE, i648FX, ATX,
FSB800, AGP8X, DDR 400 75
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 57
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 92

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D,
DDR266, RAID, 6ch audio,
AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra,
Sis645A2+961, RAID, 6ch audio,
AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BD7, i845D, FSB 533MHz,
2DDR, AGP 4X, 5 PCI 85
Abit BD7II, i845D, FSB 533MHz II,
2 DDR, AGP 4X, 5 PCI 90
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 194
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 85
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 135
Abit BD7E, i845DDX, FSB 533MHz,
2 DDR, AGP 8X,  5 PCI 75

Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 94
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 119
Abit KD7-A, Via KT400,
FSB 333MHz, 4DDR, AGP 8X, 6 PCI 86
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 27
Visipro 128MB (8 IC) PC 133 35
Visipro 256MB (8 IC) PC-133 46
Visipro 256MB (16 IC) PC-133 65
Visipro 512MB PC-133 92
Visipro 128MB (8 IC) PC-2100 28
Visipro 256MB (8 IC) PC2100 49
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 94
Visipro 128MB (4 IC) PC-2700 30
Visipro 128MB (8 IC) PC-2700 30
Visipro 256MB (8 IC) PC2700 50
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 96
Visipro 256MB PC3200 (8IC) 56
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37
Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 25
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 48
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC)
512MB 92
V-Gen DDR PC-2100  128MB 24
V-Gen DDR PC-2100  256MB 42
V-Gen DDR PC-2700  256MB 43
V-Gen DDR PC-2100  512MB 83
V-Gen DDR PC-2700  512MB 85
V-Gen DDR PC-3200  256MB 44
V-Gen DDR PC-3200  512MB 87
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 98
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT RP.100.000,-
1.Network LAN+EDP+Admin+PC Kloning
2.Teknik Komputer+Mobo+Hardisk+Copy Bios
3.Design Grafis 4. Private 5. Jarak jauh Ok
Gratis:CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
Non Hardisk bisa Windows 2000 - XP - Corell
LPKN EXSYSCOM - BELAJAR JARAK JAUH BISA
021.78889003 - 0813.100.47586 - 0815.997.1234

TRAINING RAMADHAN,Kursus Teknisi Hdd,Teknisi
Cdrom, Hardisk Bad, Teknisi Refill Toner
Cartdz,Membuat Monitor CGA/VGA menjadi
TV,Penyelamatan Data Hdd Bad-Terformat-
Terfdisk,Teknisi Monitor,Linux Non Hdd, & Aplikasi LAN:
Remote Control dan Spy. lp2m.aray: Jl.Margonda
Material Halte UI: 7872401/9236955/Harga Mhsw

CSC Kursus LAN-WAN Materi Client Server,
Admin Win2000/Internet Sharing/Warnet,Intranet
Web Server/FTP/Terminal Service(Cloning),
Hubungan Jarak Jauh Via Telp/Komunikasi,
Monitoring, 6 hari, Hub: 7373774,Jl.Mandar
Blok DE2/13,Sektor 3A,Bintaro Jaya

LAIN-LAIN

DISTRO LINUX,Menjual CD Linux terbaru.
Mandrake/Redhat/Slackware/Openoffice dll
Murah dan Bergaransi (1 to 1 Replacement)
Kualitas CD dijamin bagus ( LG/BenQ/Sony)
Bisa kirim keseluruh Indonesia. Hubungi:
08121876981 Email: distro_linux@yahoo.com
http://www.geocities.com/distro_linux/

Belajar sendiri bikin Web Database (PHP) via
CD. Instalasi server instan,tutorial lengkap untuk
pemula-mahir,ratusan script siap pakai.Tersedia
pula Ratusan web template siap pakai.Visit
www.earthweb.biz or call 0811-831835 (no sms)

IKLAN BARIS

Kingston 128MB DDR PC2100 22.5
Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

NCPRO 512MB DDR PC-3200 88
NCPRO 256MB DDR PC-3200 44.5
NCPRO 512MB DDR PC-2700 87
NCPRO 256MB DDR PC-2700 41.5
NCPRO 128MB DDR PC-2100 21.5

MULTIMEDIA CARD

NCPRO 64MB 23
NCPRO 128MB 36
NCPRO 256MB 71.5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

COMPACT FLASH

NCPRO Flash memory 32MB 18
NCPRO Flash memory 64MB 22.5
NCPRO Flash memory 128MB 38.5
NCPRO Flash memory 256MB 56

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 70
Visipro Flash Memory 512MB 125

Nexus UFD-64, USB 1.1, 64MB 31.5
Nexus UFD-128, USB 1.1, 128MB 42
Nexus UFD-256, USB 1.1, 256MB 70.5
Nexus UFD-512, USB 1.1, 512MB 141

Twinmos 64MB 27.5
Twinmos 128MB 36.5
Twinmos 256MB 64
Twinmos 512MB 121

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

NCPRO pen drive 128MB USB 2.0 48
NCPRO pen drive 256MB USB 2.0 74
NCPRO pen drive 512MB USB 2.0 123.5

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound II, 128MB, multi MP3,
voice recording, display 140
MagicStar 128 Turbo, USB 2.0,
128MB 65

Umax Flash Drive FD-201 64MB,
USB 2.0 43
Umax Flash Drive FD-201 128MB,
USB 2.0 65
Umax Flash Drive CD-101, 64MB +
SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB +
MP3 player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

Nexus UFD-64, USB Flash Drive
64MB ver 1.1 31.5
Nexus UFD-128, USB Flash Drive
128MB ver 1.1 42
Nexus UFD-256, USB Flash Drive
256MB ver 1.1 70.5

Box Pent-4 2,8CGHz, cache512Kb,
FSB800 230
Box Pent-4 3.0GHz, cahce512Kb,
FSB800 294
Box Pent-4 3,2GHz, cache512Kb,
FSB800 441

Intel Celeron 1,7GHz, c/128 62
Intel Celeron 2.0GHz, c/128 65
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21

Nexus UFD-512, USB Flash Drive
512MB ver 1.1 141

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm
ATA133, 2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 64
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 73
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 80
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 109
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 175
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 250

Seagate Ux/Cuda 5400.1 20GB
ATA 100 53.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 54.3
Seagate Barracuda 7200.7 40GB
ATA100 58
Seagate Barracuda 7200.7 80GB
ATA100 74
Seagate Barracuda 7200.7 120GB
ATA V/100 103.4
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 137.6
Seagate Barracuda SATA 80GB,
ATA100 106
Seagate Barracuda SATA 120GB,
ATA100 129.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133,
2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165

Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 112
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 135
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 185
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 260

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB
5400rpm 56
Samsung HDD 40GB
5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299
Maxtor 7000 200GB USB 2.0,
8MB Cache, 7200rpm 370

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 160
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 455
IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin, 10Krpm,
SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah
U320 36,6GB 168
Seagate Cheetah
U320  73GB 413
Seagate Cheetah U320 73.4GB
Fibre channel 525
Seagate Cheetah U320 36,7GB 321

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 43
Athlon Xp 2000+ (Thoroughbred A) 52
Athlon Xp 2100+ (Thoroughbred A) 55
Athlon XP 2200+ ((Thoroughbred A)  65
AthlonXP 2400+ fan (Thoroughbred B) 71
AthlonXP 2600+ (FSB333) + fan 87
AthlonXP 2800+ (Barton FSB333) 165
AthlonXP 3000+ (Barton FSB333) 215

AMD ATHLON XP 2000+ (BOX) +
FAN TBRED B FSB 266MHz 69
AMD ATHLON XP 2200+ (BOX) + FAN
TBRED B FSB 266MHz 77
AMD ATHLON XP 2400+ (BOX) + FAN
TBRED B FSB 266MHz 86
AMD ATHLON XP 2600+ (BOX) + FAN
BARTON FSB 333MHz, CACHE 512 105
AMD ATHLON XP 2500+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 94
AMD ATHLON XP 2800+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 189
AMD ATHLON XP 3000+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 269
AMD ATHLON XP 3200+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 489

Intel Pentium-4 1,8AGHz-478 128
Intel Pentium-4 3,06GHz, box), 478 278
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 130
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 133l
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 171
Intel Pentium-4 2,66GHz, (512)
FSB 533 174
Intel Pentium-4 2,8GHz (512) FSB 533 210

Tray Pent-4 2,4CGHz,
cache 512Kb, FSB 800 w/o fan 186
Box Pent-4 2,4CGHz, cache 512Kb,
FSB 800 184
Box Pent-4 2,6CGHz, cache512Kb,
FSB800 188
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1. Dwi Nofrina
Gg. Endra No.8 Gejayan
Jogjakarta 55283

2. Nasrudin Yasin
Dinas Kehutanan Kab. Gorontalo
Jl. Rajawali 295 Kec. Limboto 96219

3. Reko Satrio
Jl. Rotan Sempurut No.104 Juanda 8
Samarinda 75124

4. Luqman Mubarok
Jl. Gunung Cupu No.113 Gandasari
Cikoneng - Ciamis 46261

5. Alim Safari
Sendowo Blok F-139
Jogjakarta 55284

KUIS Beberapa waktu lalu, Lala kawan si Ciplus kembali dari Taiwan.
"Ada apa sih di Taiwan?", tanya si Ciplus. "Ada pameran
komputer", jawab Lala. "Pameran komputer,  apa namanya?", pikir

si Ciplus. Tolong dong si Ciplus, sebutkan nama pameran komputer tahunan yang
diadakan di Taiwan? Tuliskan jawaban tersebut di sehelai kartu pos dengan mencantumkan
alamat yang jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan
menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat
tanggal 08 Desember 2003. PCplus akan memberikan 5 buah kaos PCplus untuk 5 orang
pemenang yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 148/III/2002:
Chatting, Teleconferensi, Sebagai fasilitas security, Presentasi, dll.

| 31

plusHarga IV • 11 - 17 November 2003
PCplus 152

Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

CASING

Procase ATX PS/2 tipe 477
power supply 350W 23
Procase ATX PS/2 tipe 0207
power supply 350W 24
Procase ATX PS/2 tipe 0208
power supply 350W 26

Enermax ATX CS-5190 AL,
power supply 365W 404
Enermax ATX CS-5190 AL,
power supply 450W 419
Elan Vital S15, big tower, ATX,
power supply 300w 472

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T 64MB MX440-8X 84
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x, 128MB DDR 567
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 84
Asus V9520 Home Theater-128MB 189
Asus V9280 SuperFast/TD,
Ti4200-128MB 173
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 546
Asus V9180 SE/T 64MB, MX-440-8X 53

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56
Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz, TV-out, DVI Port 88
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out, DVI Port 155
PixelView GeForce FX 5600 Vivo,
128MB DDR, GPU 400MHz,
RAM 550MHz 160
PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz,
DVI port 190
PixelView GeForce FX 5900
256MB DDR II, 2,2ns, GPU 400Mhz 460
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 355
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 195

PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 88

MSI G4 MX440SET, AGP4X,
64MB SDR, TV OUT 46
MSI G4MX440 T8X, AGP4X,
64MB SDR, TV OUT 50
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 42
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 150
MSI FX5200-T128, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 89
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 120
MSI FX5600-VTDR256, AGP8X,
256MB DDR, DVI, VIDEO IN, TV OUT 250

Gainward GF4MX440, 64MB,
5.0ns DDR, AGP8X, TV OUT 46
Gainward GeForce FX 5200,
128MB, 4.0ns DDR, AGP8X, TV OUT 72
Gainward GeForce FX 5600,
128MB, ULTRA FAST DDR, AGP 8X,
TV OUT 135
Gainward GeForce FX 5600, 256MB,
ULTRA FAST DDR, AGP 8X, TV OUT 165
Gainward GeForce FX5900, 128MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 385
Gainward GeForce FX5900, 256MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 450

Elsa Quadro FX2000, 128MB DDR II,
AGP 8X VIVO, DVI-I 1558
Elsa Quadro FX1000, 128MB DDR II,
AGP 8X, DVI-I 1006
Elsa Quadro FX500, 128MB DDR,
AGP8X, DVI-I 335
Elsa Gladiac FX930, GeForce FX5800,
128MB, AGP8X, VIVO, DVI-I 370
Elsa Gladiac FX732, GeForce FX5600,
128MB, AGP8X, VO, DVI-I 178
Elsa Gladiac FX534, GeForce FX5200,
64MB, AGP8X, VO, DVI-I 107
Elsa Gladiac 528 (VIVO), GF4 Ti4200,
AGP8X, 128MB DDR, VIVO 161
Elsa Gladiac 518, GF4 MX440,
AGP8X, 64MB DDR, TVO 62
Elsa Gladiac 517SEP, GF4 MX440,
64MB DDR, TVO 53
Elsa Falcox 980FX-256,
Radeon 9800, 256MB VO, DVI 456
Elsa Falcox 980FX-128,
Radeon 9800, 128MB VO, DVI 347
Elsa Falcox 960FXPRO-128MB,
Radeon 9600, 128MB, VO DVI 211
Elsa Falcox 960FX-128,
Radeon 9600, 128MB, VO DVI 150
Elsa Falcox 920FX-128,
Radeon 9200, 128MB, VO DVI 100
Elsa Falcox 920SE-64MB,
Radeon 9200, 64MB, VO DVI 65

Sapphire Radeon 9200SE-D64,
64MB DDR, TVI, AGP8X 61
Sapphire Radeon 9200 D64, 64MB
DDR,TVO, AGP8X 71
Sapphire Radeon 9200 D128,
128MB DDR, VIVO, AGP8X 109
Sapphire Radeon 9600 D-128,
128MB, DVI, VIVO, AGP8X 145
Sapphire Radeon 9800Pro D-128,
128MB DDR, DVI, AGP8X 470

Sapphire Radeon 9800Pro D256,
256MB DDRII, DVI, AGP8X 551

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se nVidia LMA II,
64 MB 128-bit DDR 350 Mhz,
CRT+TV out 49
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               80
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 165
DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     198

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb,
tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9600 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I,
twin view 137
Gigabyte R9800 Pro , radeon 9500,
TV-out S/RCA, DVI port DVI-I,
twin view 407
Gigabyte R9000 Pro, ATI Radeon
9000Pro, 64MB DDR, TV-out,
S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 67
Gigabyte R9600 Pro, ATI Radeon
9600 Pro, 128MB DDR 192
Gigabyte R-9800 Pro, Radeon
9800Pro, 380MHz/ 680MHz, 256MB 522
Gigabyte R-9200 (VIVO),
Radeon 9200, 250MHz/ 400MHz,
128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW 40x12x48 box 135

Gigabyte  CD ROM 52X 26

MSI CD-ROM C-52 20
MSI CR-52M, 52x32x52 48
MSI CRE-52M CD-RW external 120

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224 A-U
(USB) 52x24x52 100
Asus external slim combo
SCB 2408-D 210
Asus CRW 5224A, 52x24x48 48

TDK CDRW 52x24x48 D
second edition black 50
TDK CDRW 52x24x48 D
second edition white 48
TDK CDRW 48x16x48
USB External 2.0 115
TDK CDRW 52x24x52 int
IDE loose pack 65

Gigabyte CD-RW 52x32x52 54

Plextor CD RW 52x32x52 Internal IDE 155
Plextor CD RW 24x10x40 external
USB slim 175
Plextor CD RW 24x10x40 external USB 120
Plextor CD RW 12x10x32 SCSI external 245
Plextor CD RW Combo DVD
8x8x24 ext USB 2.0 255

Whale CD ROM 56x 17
Whale CD-RW 52x24x52 46

DVDRW

Gigabyte GO-W404A DVDRW (+/-) 237

Pioneer DVD (+/-) RW A06 250
Plextor PX 504A DVD (+)RW
INT IDE 2,4 X 4 200
Plextor PX504UF DVD+RW EXT
firewire + USB 345
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 300
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 SC 385
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 FC 400

Aopen DVD-RW Combo ultra slim, box 290

Asus DVD-R/RW 4X2X12 247

TDK DVD-RW 440 250

MSI DVD combo X-48 80

DVD-ROM

Pioneer 120T 9 (Trayload) 45
Pioneer 120S (slot in) 55

Samsung DVD 16X 34

Sony DVD 16X white 32
Sony DVD 16X Black 34

Asus DVD 16X 43

MSI DVD-ROM 38

TV TUNER

MSI TV Anywhere, conexant
CX23883, remote,
video editing 52

Jetway USB, TV tuner, radio,
remote USB 67

PixelView Play TV USB 2.0,
ext USB TV tuner + FM radio, remote 90
PixelView Play TV HD/s,
TV tuner card + FM radio, remote 55
PixelView Play TV HD,
TV tuner card + FM radio 43

Asus TV tuner 75

HUB

Nexus UH504, UFO USB
hub 4 port USB 1.1 9.5
Nexus UHC04, Stick USB
hub 4 port USB 1.1 9.5
Nexus UHV34, Crystal USB
hub 4 port, USB 2.0 with
power adaptor 20
Nexus UH634, Bugs, USB hub 4 port,
USB 2.0 with power adaptor 20
Nexus UH904, sharing USB for
2 computer, 4 USB 1.1 20
Nexus UHK34, sharing USB for
2 computer, 4 USB port,
USB 2.0 + adapter 27
Nexus HUB-SW5P, mini hub 5 port 10/
100Mbps, N-way switch 32
Nexus HUB-SW8P, mini hub
8 port 10/100 Mbps, N-way switch 36
Nexus HUB-SW16B, mini hub
16 port 10/100Mps, N-Way switch 71

SPEAKER

Sonic Pulse C230 6
Sonic Pulse C240 9
Sonic Power P121 17
Sonic Power P121X 21
Sonic Power P221X 20
Sonic Power P320 37
Sonic Power P320R 48
Sonic Power P321 51
Sonic Power P350R 58
Sonic Power P360R 68
Sonic Power P521 71
Sonic Power P600X 64
Sonic Pro X480 61
Sonic Pro DTS800 301

MONITOR

Prolink Chameleon 150A 305
Prolink Chameleon 170A 445
Prolink Chameleon 170V 470
Prolink Chameleon 170T 570

BenQ FP567s , LCD 15" 269
BenQ FP767, LCD 17" 399
BenQ FP731 , LCD 17" 379
BenQ FP581s , LCD 15" 329
BenQ FP781 , LCD 17" 459
BenQ FP591 , LCD 15" 480
BenQ FP791 , LCD 17" 605
BenQ FP882 , LCD 18" 725

LCD Monitor Colortac LM 15Xn 298
LCD Monitor Colortac
LM 17Xn 495
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